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1 What is DanioVision?

daniovision

DanioVision™ is a system for high throughput tracking of zebrafish 
larvae in multi-well plates. It consists of:

The DanioVision Observation Chamber (DVOC-0041)

See Figure 1. This chamber contains a transparent holder with backlight 
that fits an ANSI SBS compatible multi-well microtiter plate, infrared 
(IR) and white light sources (underneath the microtiter plate), and a 
Gigabit Ethernet (GigE Vision) video camera. The optical design 
provides a stable and undistorted top view of each well and a 
controlled and constant environment within the observation chamber.

For technical specifications and for cleaning instructions, see System 
specifications.

tip  You find your DanioVision’ version number on 
the label at the back of the chamber.

Figure 1  The DanioVision Observation Chamber DVOC-0041.
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EthoVision® XT

Video-tracking software with the Multiple Arenas Module and Trial & 
Hardware Control Module. With this module you can adjust the white 
light stepwise based on time or behavior of your fish. You have the 
option to connect external devices, such as sound or shock generators.

note  DanioVision DVOC-0041 works with EthoVision XT 10.1 and later.

daniovision add-ons

DanioVision Temperature Control Unit

With the DanioVision Temperature Control Unit you can set up a water 
flow at constant temperature underneath the well-plate. For details, 
see The DanioVision Temperature Control Unit on page 76.

DanioVision Tapping Device

With the DanioVision Tapping Device you can trigger a startle response 
in zebrafish. For details, see The DanioVision Tapping Device on page 
113.

DanioVision Toplight Unit

With this add-on you can generate top-down light stimuli in your 
experiments. Four types of light are available: white, red, blue and 
green. For details, see The DanioVision Toplight Unit on page 120.

DanioVision with Optogenetics

DanioVision can be provided with one to three LEDs that illuminate the 
well plates based on your Trial Control protocol. The Optogenetics add-
on allows to accurately control and time the application of optogenetic 
stimulation to up to 96 individuals simultaneously (one for each well in 
a 96-well plate). For details, see The DanioVision Optogenetics add-on 
on page 130.

Custom solutions

As research evolves, so do research needs. If you are interested in a 
custom solution, don’t hesitate to contact us!
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A few examples of recent custom solutions:

 Light-Dark Grid. Commonly used to investigate anxiety behavior in 
zebrafish. The grid is placed underneath the well plate (available for 
6, 12, 24, 48 or 96 wells) and creates a dark and light half in each 
well. The grid is IR light translucent, leaving the tracking of the 
zebrafish unaffected.

 High-speed camera. DanioVision is equipped with a camera 
capable of 1000 frames per second. The aim is to measure the 
startle response of larvae to a stimulus during a Pre-Pulse Inhibition 
test (Burgess and Granato 2007). 

 Split basin. The DanioVision basin has been modified so that it 
receives water at two different temperatures. The aim of this 
solution is to measure temperature preference in zebrafish larvae. 

 Ultraviolet Toplight Unit. This is a modification of the Toplight unit 
(see the previous page), which shines UV light. Light intensity is 
controlled by EthoVision XT.

 Turbo-cooling TCU. This is a modified Temperature Control Unit 
which keeps water at a constant temperature of 12° in a room 
where temperature is about 25°.

for more information

Manuals

For more information, see

 The EthoVision XT Help (press F1 in the EthoVision XT).

 The EthoVision XT - Trial and Hardware Control - Reference Manual. 
To open this and other manuals, from the Windows Start menu 
choose All Apps > Noldus > EthoVision XT 18 Other Documentation.

You can also find the manuals on the Noldus web site.

my.noldus.com

After login, choose Downloads > EthoVision XT > Documentation.
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Sample experiments

On the EthoVision XT downloads page you can find two sample 
experiments that make use of DanioVision. Browse to my.noldus.com, 
then after login choose Downloads > EthoVision XT > Sample 
Experiments. 

Once you have downloaded a sample experiment file (*.evz), you can 
open it in EthoVision XT (File > Restore Backup).

Experiment templates

EthoVision XT contains templates that help you setting up an 
experiment with arenas, analysis profiles and other elements already 
defined. See create a daniovision experiment on page 42.

Camera drivers

If, for any reason, you need to re-install the driver software of the 
DanioVision camera, do the following:

1. Double-click the file EthoVision XT 18 - Setup [version number].exe 
and choose Modify. 

2. Under Drivers and tools, select to install the Basler GigE Camera 
driver and follow the instructions on the screen.

If you do not have the installation files, download EthoVision XT - 
Installation Package - 18.0 from

my.noldus.com

Installing the Basler driver from the installation file

Alternatively, you can download the single installation file for the 
Basler camera driver. However, if you choose this route you must select 
the custom setup, as described here below. Follow the instructions 
carefully.

Browse to

my.noldus.com

1. After login, choose Downloads > EthoVision XT > Drivers and Tools 
and under Drivers for the current version download Basler Pylon 
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Camera Driver - Noldus - [version number]. Extract its content and 
copy everything to the local disk.

2. Double-click Basler_pylon_[version number].exe. Accept the Terms 
and Conditions, then click Next.

3. Under Profiles, select Custom and click Next. 

4. Under Features, choose GigE Camera Support. This applies to the 
DanioVision camera. Make sure to select pylon Viewer and 
DirectShow Support. 

5. Complete the installation.

For more information, open the EthoVision XT Help and browse the 
chapter Camera Installation.

References

See our web page of selected publications:

www.noldus.com/daniovision/resources

Support center

If after reading this manual you still have questions, please contact our 
Support center at my.noldus.com.
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2 What’s new in DanioVision

daniovision observation chamber

For users of DanioVision DVOC-0040

The white light LED array has been improved. The White light can be set 
to higher intensity.

For users of DanioVision DVOC-0030

 The housing has been completely redesigned. You open the 
observation chamber by tilting the lid along the top side. This way 
you have easier access to the camera and opening/closing the lid 
produces less vibration.

note  The DanioVision Observation Chamber is designed to block 
light from the outside. However, it cannot be guaranteed that it is 
completely dark inside the Chamber. For experiments that require 
absolute darkness (like experiments with day-night rhythms), place 
the DVOC in a dark room.

 The housing is now larger to create more space for accessing the 
video camera or adding devices. For this purpose, the housing can 
12  2 - What’s new in DanioVision



be disassembled more easily than before. For the instructions see 
page 166.

 The basin has been redesigned. It has now a more flexible retainer 
that can hold a wider range of well plates. DanioVision can now 
work with ANSI, SBS compatible micro plates (L =127.76± 0.5 mm, 
W=85.48 ± 0.5 mm) with a maximum height of 27 mm, and with 
Petri dishes with a diameter up to 90 mm. To place small well 
plates and petri dishes, slide the bridge to a new position in such a 
way that the well plate/petri dish is in the middle of the camera 
view (left). For details see place well plates and petri dishes on 
page 38.

 The mechanism for moving the Fresnel lens located above the well 
plate has been improved. You can now move the lens all the way 
out of the camera view when you need to place containers higher 
than 27 mm. 

 Communication between DanioVision and EthoVision XT has 
improved via a new version of the hardware interface software. See 
install ethovision xt on page 23. 

 All four TTL lines TTL 1 to TTL 4 are available for communication with 
external devices. For connecting custom hardware, additional 
expansion connectors Expansion 1 and 2 are available. See Figure 3 
on page 16.

Figure 2  Positioning a well plate (left) and a petri dish (right). 
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 The White Light is now dimmable at very low intensity, without the 
need to operate the Low light switch located behind the camera. 

 The DanioVision Tapping Device has been designed to provide 
DanioVision with a reliable device which evokes a startle response 
in zebrafish larvae. See The DanioVision Tapping Device on page 
113.

note  The DanioVision Tapping Device is a separate add-on to the 
DanioVision system.

For users of DanioVision DVOC-002x

 The DanioVision camera is now a Gigabit Ethernet (GigE) digital 
camera connected to the EthoVision XT computer through a 1-Gb 
Ethernet card. With a GigE camera, tracking can be done with a 
higher sample rate and higher resolution. 

 The intensity of the infrared LED back-lighting has been increased. 
This results in a more even distribution of back-lighting over the 
well-plate and a higher contrast between animals and the 
background. Therefore, it is easier to configure the detection 
settings and detection is better.

 It is possible to use very low light levels for the DanioVision White 
Light in addition to the default, standard White Light levels. The 
standard White light levels range from ±20 to ±10000 lux. The low 
White light levels range from 0 to ±20 lux.

 The anti-condensation mechanism can now be easily switched on 
and off, or set to automatic. The anti-condensation mechanism 
prevents the lens from condensing during an experiment.

ethovision xt

 White Light. When programming the White Light on/off action, you 
can now set the fade duration in milliseconds, seconds, minutes, 
and hours (maximum 24 hours).
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For a description of the new features in EthoVision XT, see the topic 
What’s new in EthoVision XT in the EthoVision XT Help.
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3 Set up DanioVision

connections

The back panel of the DanioVision Observation Chamber contains the 
following connections (see Figure 3 below):

1. Expansion 1. You can optionally use this connector to set up to 4 TTL 
out lines, to control external devices. For details, see page 177.

2. Temp. Connector for the temperature sensor. Use this in 
combination with the DanioVision Temperature Control Unit (TCU; 
see page 76).

3. Cable grommet. If you install additional hardware inside the 
observation chamber, puncture the rubber membrane to let the 
cables pass through. For example, to connect the sensor of a digital 
thermometer placed in the water basin to a digital display outside 
the DanioVision Observation Chamber.

4. Gigabit Ethernet (GigE) camera connector. Use this output to 
connect the DanioVision camera to the EthoVision XT computer.

Figure 3  The back panel of the DanioVision Observation Chamber. See text for 
explanation. The label with the CE marking contains the product version.
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5. Expansion 2. This is a RJ45 type, 8-pin feed through connection. You 
can use it to connect future internal add-on hardware to get external 
signals in the DanioVision Observation Chamber.

6. Connector for water flow (see page 19 for details).

7. TTL1 to TTL4. You can optionally use these TTL input/output 
connections to control external devices such as a sound or shock 
generator, or the DanioVision Temperature Control Unit.

8. USB port (type Standard-B) to connect the DanioVision Observation 
Chamber to the EthoVision XT computer.

9. Connection for the 24 V power supply.

10.Connectors for water flow (see page 19 for details).

connect daniovision

Make sure the DanioVision Observation Chamber is placed on a level 
surface!

Power

Connect the DanioVision Observation Chamber’s 24 V socket (9 in 
Figure 3) to the power supply using the power cable and adapter.

Video

Use the Ethernet cable with the large round connector to connect the 
digital video output of the DanioVision Observation Chamber (4 in 
Figure 3) to the Ethernet port labeled DanioVision camera on the 
EthoVision XT computer. 

The DanioVision camera must be connected to a 1-Gb Ethernet card. 
See page 24 for how to install this card on your computer. If you have 
purchased a PC from Noldus together with DanioVision, this card is 
already installed. Contact Noldus if you need a new Ethernet card for 
the DanioVision camera.
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White Light, Tapping Device, and other hardware

Use the USB cable that comes with DanioVision to connect the USB 
port of the DanioVision Observation Chamber (8 in Figure 3) to a USB 
port on the EthoVision XT computer. Do this only if:

 You want to control the White Light or the Tapping Device in the 
DanioVision Observation Chamber during data acquisition in 
EthoVision XT.

 You have the DanioVision Temperature Control Unit and you want 
EthoVision XT to take action if the water temperature gets too low 
or too high.

 You want to control any custom hardware connected to the 
DanioVision Mini USB-IO box.

Figure 4  Basic connections between the EthoVision XT computer and the 
DanioVision Observation Chamber. For controlling other devices like the Toplight 
Unit and the Temperature Control Unit, see the corresponding sections.
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set up a water-flow system

If you require a temperature-controlled water flow underneath the 
well plate, the Noldus DVTCU Temperature Control Unit is the preferred 
method.

The back panel of the DanioVision Observation Chamber contains 
three connections for controlling the water flow (see Figure 6): a water 
inlet (marked in green), a water outlet (marked in yellow) and a water 
overflow (marked in red).

Figure 5  The DanioVision DVTCU Temperature Control Unit.

Figure 6  The back panel of the DanioVision Observation Chamber, with the 
numbers indicating the connections of the water-flow system: 
 1 - water inlet; 2 - water outlet; 3 - water overflow.
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Connect the DanioVision Observation Chamber to the DVTCU using the 
tubes that match the color of the connectors. Please see page 76 for the 
instructions.

Suggested temperature

For Danio larvae, the temperature of the water flowing through the 
system is usually 28 degrees Celsius. You can set a different 
temperature when needed.

Figure 7  Tube connections between the DanioVision Observation Chamber and 
the DanioVision Temperature Control Unit. Color dots represents colors on the 
tubes. Arrows indicate the water circulation. 
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light and switches

Main switch

The main switch is located on the front panel. After you switch on 
DanioVision, wait at least 15 minutes for it to ‘start up’ and to avoid 
condensation in the system.

 

Internal LED light

The DanioVision Observation Chamber is equipped with a LED light to 
illuminate the inside of the chamber while you set up your experiment.

Operate the Light switch at the left of the camera to turn the light on 
and off.
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Anti-Moisture switch

This switch is located at the right of the camera. Operate this switch to 
adjust the anti-condensation mechanism (page 36).

Low light switch

This switch is located on the Mini USB-IO box, behind the camera at the 
back of the observation chamber.

 When the switch is set to H (default), the standard light levels are 
activated, from ±20 to ±10000 lux.

 Set this switch to L to allow very low light intensities, from 0 to ±20 
lux. For details, see page 37.
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install ethovision xt

 If you have purchased the DanioVision Observation Chamber 
including a computer from Noldus Information Technology, all 
software has been installed and tested. You can skip this section.

See Set up EthoVision XT on page 42

 If you use your own computer (or a computer you bought from 
Noldus IT in the past; in that case, make sure it meets the 
EthoVision XT system requirements), see below.

For information about system requirements, press F1 in EthoVision XT.

Mini USB-IO box drivers

The Mini USB-IO box is the embedded electronics unit that 
communicates with EthoVision XT. The Mini USB-IO box makes it 
possible for EthoVision XT to control for example the white light 
stimulus. 

Before installing EthoVision XT, remove older versions of the drivers for 
the Mini USB-IO box. To do so:

1. In the Windows Control Panel select Programs and features.

2. Click each of the items whose name begins with Noldus - Hardware 
InterfaceIoBox and click Uninstall.

3. If you have not done so, download the installation files from 
my.noldus.com and run the Setup.exe file. If EthoVision XT is already 
installed, click Modify and complete the procedure.

When you install EthoVision XT, the drivers of the Noldus Mini USB-
IO Box are automatically installed.

Upgrading old experiments

 When you open an experiment from EthoVision XT 12 or earlier, a 
warning appears informing you that you cannot open upgraded 
experiments in the old version of the software anymore. Do one of 
the following:

- If the older EthoVision XT version is still on the PC, make a 
backup of your DanioVision experiment in that version before 
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opening it in EthoVision XT. To make a backup, choose File > 
Make Backup.

- If the older version is no longer on the PC, you cannot use the 
Backup function. Instead, make a copy of your experiment using 
Windows Explorer before you open it in the newer EthoVision XT 
version. Always copy the complete experiment folder and not 
only the *.evxt file otherwise your experiment does not open. 
Keep the original experiment as a backup.

For more information

See Installation in the EthoVision XT Help for instructions on how to 
install EthoVision XT.

For more information on the Mini USB-IO box, see the EthoVision XT 18 
- Trial and Hardware Control - Reference Manual. To open this manual, 
from the Windows Start menu choose All Apps > Noldus > EthoVision 
XT 18 Other Documentation.

install the network card for the 
daniovision camera

DanioVision works with a Basler Gigabit Ethernet (GigE) video camera, 
connected via a 1-Gb Ethernet card installed on your computer.

Figure 8  An Ethernet card for connecting the DanioVision camera to the 
EthoVision XT computer.
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 If you ordered a computer from Noldus Information Technology 
when you purchased DanioVision, it came with that card already 
installed and tested. You can skip the instructions below and 
continue with Chapter 4 on page 33.

 If you bought your computer somewhere else, you have to install 
the Ethernet card yourself. Follow the steps below.

Step 1. Insert the Ethernet card in the DanioVision computer

1. Turn off your computer and all connected peripherals, such as the 
monitor and printer. Make sure that the computer is unplugged.

2. Remove the PC's casing according to the instructions provided in the 
PC's user manual.

3. Select a free PCIe expansion slot, and remove the corresponding 
extension cover.

When possible, choose the slot that gives maximum performance. 
To estimate performance, take note of the slot version (2, 3, etc.) 
and compare it with the following values:

- PCIe v1.x: 250 MB/s

- PCIe v2.x: 500 MB/s

- PCIe v3.0: ~1 GB/s

- PCIe v4.0: ~2 GB/s

- PCIe v5.0: ~ 4 GB/s

- PCIe v6.0: ~8 GB/s

Note that values are given per lane; they should not be multiplied 
by the number of lanes in a slot (e.g. x4) since the card has a 1x 
connector (that is, one lane). For example, SLOT1-PCIe3x4 means 
version 3.0 with four lanes.

important  Do not insert the PCIe board in the blue or white slots.

4. Unpack the Ethernet card, place it into the slot, and press it carefully 
into position. If the card does not fit into place easily, remove it and 
repeat the operation.
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When touching the board, its electronic components can be 
damaged by static electricity. To avoid any such risk, make sure that 
you are grounded. You can ground yourself by putting on an 
earthing wristlet, and attaching its clip to the metal frame of the 
computer. If an earthing wristlet is not available, you can hold the 
metal frame with one hand while holding the Ethernet card in your 
other hand. Ensure also that your clothing does not touch any 
components while handling the card.

5. Fix the card to the chassis and re-fit the computer's cover.

For more information about installing the camera and the Ethernet 
board, see Camera Installation in the EthoVision XT Help.

Step 2. Install the camera drivers

1. If you have not done so, download the cameras driver software 
from my.noldus.com. Log in or register, then choose Downloads > 
EthoVision XT > Drivers and Tools. Under the EthoVision XT version 
that applies, download the Basler Pylon Camera Driver - Noldus - 
[version number].

2. Double-click Basler_pylon_[version number].exe. Accept the Terms 
and Conditions, then click Next.

3. Under Profiles, select Custom and click Next. 

4. Under Features, choose GigE Camera Support. Also select pylon 
Viewer and DirectShow Support. 

5. Complete the installation.
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6. Connect the DanioVision camera to the port of the Ethernet card 
using a network cable (see D in Figure 3 on page 16).

Step 3. Assign the IP address to the Ethernet card

tip  Watch the video tutorial Set Up the Camera. In EthoVision XT, 
choose Help > Video Tutorial.

1. In Windows (here version 10), search for Network Connections. 

2. Right-click the Local Area Connection and click Properties. If your 
computer has more than one Local Area Connection, choose Basler 
GigE Vision Adapter. Write down the number of this connection.

3. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

4. Select the options: Use the following IP address and Use the 
following DNS server addresses and fill in the details as shown in the 
next figure. 
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Also select the checkbox Validate settings upon exit. When done, 
click OK and then Close. 

Step 4. Set the IP address of the DanioVision camera

tip  Watch the video tutorial Set Up the Camera. In EthoVision XT, 
choose Help > Video Tutorial.

1. In Windows, search for IP Configurator and start this application.

2. Select the camera. 

3. Fill in the details in the IP Address and Subnet Mask fields under 
Static IP Address as shown in the figure below. 

4. Click Save and then Close. 
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5. Follow the instructions below to configure the DanioVision camera.

For more information about setting IP addresses, see Install GigE 
cameras in the EthoVision XT Help.

configure the daniovision camera

Camera settings

The DanioVision camera that you received is already configured 
according to your setup. Noldus created three main settings profiles, 
called User Sets, stored in the Pylon Viewer software which controls the 
camera: User Set 1, User Set 2 and User Set 3. Only one User Set can be 
active at a time.

For each video resolution, you must use different camera settings and 
in some cases a different camera lens. For example, the video 
resolution determines the maximum frame rate. The higher the 
required resolution (in number of pixels), the lower the maximum 
frame rate (in frames per second). The three User Sets are specific for a 
combination of video resolution and frame rate (Table 1).

Which User Set is currently selected?

Make sure that EthoVision XT is closed. Start the Basler Pylon Viewer 
software and in the Features panel (for details, see the procedure in the 
next pages), under Configuration Sets, look for the item Default 
Startup Set. This is the User Set that contains the current settings.

Always check that the settings in Pylon Viewer for a particular User Set 
correspond to those in the table!

Note

EthoVision XT reads the settings from the camera driver software. For a 
specific EthoVision XT experiment you can override the values of video 
resolution and frame rate values that are stored in the driver, not other 
settings; see page 46.

The maximum frame rates have been measured with a 96 well plate 
setup. Other values may be optimal in other setups.
3 - Set up DanioVision 29



1 User Set 1 is default for most applications. User Set 2 is pre-selected if 
you purchased a 12 mm lens and you work with a high frame rate. User 
Set 3 is pre-selected if you purchased a 8 mm lens.

2 For User Set 2, Binning mode must be Summing. For other User Sets 
either option has no effect with binning equal to 1.

3 For all User Sets: Enable Acquisition Frame Rate must be selected.

Table 1  Overview of predefined User Sets in the camera driver software and 
associated video frame rate, video size and required camera lens.

Resolution and 
maximum frame rate

1280 x 960, 
30 fps

640 x 480,
60 fps

800 x 600,
60 fps

Camera lens 12 mm 12 mm 8 mm + 
0.5 mm 
spacer ring

Settings in Pylon Viewer

A User Set1 User Set 1 User Set 2 User Set 3

B Pixel Format Mono 8 Mono 8 Mono 8

C Analog Gain 1 0 1

D Center X and Center Y

E Horizontal binning, 

Vertical binning2
1, 1 2, 2 1, 1

F Exposure TIme (Abs)  

in microseconds 3 
4000 2000 4000

Settings in EthoVision XT

G Resolution 1280 x 960 640 x 480 800 x 600

H Frame rate (fps) 30 60 60

I Color space Y800 Y800 Y800
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Adjust the camera settings in EthoVision XT

In EthoVision XT, choose Setup > Experiment Settings and click the 
camera button. Adjust the settings according to the table on the 
previous page.

For details, see Adjust camera Settings in EthoVision XT in the 
EthoVision XT Help.

Adjust the camera settings in Pylon Viewer

You can also adjust the camera settings directly in the camera software 
Pylon Viewer. Adjust the settings according to the configuration you 
want to use in Table 1. First, choose a video resolution and frame rate 
combination, then mount the recommended camera lens, and next 
make the appropriate settings in Pylon Viewer. Finally, adjust the 
appropriate settings in EthoVision XT.

For more information about Pylon Viewer, see the Configure the digital 
camera in the EthoVision XT Help.

 Pixel format (column B inTable 1). 

 Analog gain (column C in Table 1).

 Center X and Center Y options (column D in Table 1). 

 Horizontal and Vertical binning (column E in Table 1).

 Acquisition frame rate and Exposure time (column F in Table 1).

tip  To preview the camera image, click the Continuous Shot 
button on the toolbar. 

tip  You can increase the Analog gain to 2 or higher if you need a 
brighter image. However, the image noise will also increase, which may 
influence tracking.

Do not forget to save the camera settings!

To save the settings, click the Stop button and open the 
Configuration Sets item. From the Configuration Set Selector 
list, select the User Set you want to save the settings to. Next to User 
Set Save, click Execute. Select the User Set you want to use at a daily 
basis. From the Default Startup Set list, select the User Set of your 
choice.
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Camera view

Check that the camera view is correct by placing a wellplate in the 
DanioVision Observation Chamber. 

Make sure that:

 The well plate is in the middle of the field of view, not rotated or 
skewed. If not, see page 175.

 The well plate is in focus. If not, operate the focus ring of the 
camera lens.

 Fixation screws of all rings on the lens are tightened.

 The aperture is chosen such that the image appears slightly 
overexposed. With water in the well plate, the image is fine.

When you create an EthoVision XT experiment, check that the video 
Resolution, Video frame rate and Color space are as in Table 1 (page 30) 
for the User Set you want to use. 

See the next chapter and also Fine camera adjustments on page 172.
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4 Check the DanioVision system

Before you start setting up EthoVision XT, you need to check the 
following:

Camera

 The camera lens should have the correct aperture and must be in 
focus.

See page 34 

 The camera is correctly configured.

See page 29 

Anti-condensation mechanism

 You need to do this depending on the temperature inside the 
DanioVision chamber and the desired water temperature around 
the well-plate.

See page 36

White Light stimulus

 You need to do this when you want to use very low intensities for 
the DanioVision White Light.

See page 37 

Well plates and Petri dishes

 The well plate or Petri dish must be inserted correctly.

See page 38 

 Always control evaporation in the basin and in the well plate, 
especially when you carry out long trials (> 1 day).

See page 41 
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check the camera lens

Although the camera and lens are set up before shipment, the settings 
of the lens can shift during transport. Before you start to work with the 
DanioVision system, please check that the lens is set up correctly by 
doing the following:

1. The lens you use depends on the video resolution and frame rate 
you want to use. See the table on page 30.

2. Insert a well plate (o petri dish) in the basin.

3. Create a new EthoVision XT experiment (see create a daniovision 
experiment on page 42) and open the Arena Settings to see the 
camera image.

When water is not present in the basin, the image of the well plate 
should look overexposed, like the following:

4. Check the focus (see Figure 9). If the camera image is not in focus, 
loosen the screw, adjust the focus and tighten the screw.

The camera should be focused on the animals. The distance 
between animals and camera does not change much between 
types of well-plate and water level in the wells, however it is always 
a good idea to check the image before an experiment and adjust 
the focus until it is optimized.
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5. Check the aperture ring (see Figure 9).

The aperture has been adjusted in such a way that when the basin 
is filled with water, the video image is optimal for tracking (see 
example of a good video image on page 176). However, in the 
Detection Settings (page 66) always check that detection of the 
larvae is good. If necessary, adjust the aperture to get a better 
contrast between the larvae and the background.

6. Make sure the camera is correctly configured (see page 29).

Notes

The more the lens aperture is set toward C (Close), the larger the so-
called depth of field is. This means that the subject looks ‘sharp’ in a 
wider range of distances from the lens. This is especially relevant when 
you work with a zoom lens and zoom in to focus on a smaller region of 
a well plate. If the aperture is set to O (Open), the subject may look 
sharp only at a certain water depth.

On the other hand, closing the aperture has the main disadvantage 
that it decreases the contrast between the subject and the background. 
Adjust the aperture until the image is optimized.

Figure 9  Left: a 12 mm standard camera lens. Right: A 8 mm camera lens.  
The 8 mm lens has a spacer ring already installed if you purchased this lens 
from Noldus. See also Table 1 on page 30 for which camera settings apply to 
which lens.
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configure the anti-condensation mechanism

Anti-Moisture switch

The DanioVision Observation Chamber is equipped with an anti-
condensation mechanism to prevent water droplets forming on the 
lens during an experiment. A temperature sensor inside the 
DanioVision Observation Chamber checks whether the anti-
condensation mechanism should be switched on or off when it is set to 
Auto mode. Besides the Auto mode, you can also permanently switch 
the anti-condensation mechanism On or Off. The Anti-Moisture switch 
is located behind the camera, at the right side.

Auto 

Default and recommended when the DanioVision TCU is not used. The 
anti-condensation mechanism is automatically switched on when the 
air temperature inside the chamber drops below 28 °C (82.4 °F) to 

Figure 10  Position of the Anti-Moisture switch inside the 
DanioVision Observation Chamber.
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prevent condensation on the lens. When the air temperature inside the 
chamber exceeds 28 °C, the anti-condensation mechanism is 
automatically turned off to prevent heating of the water in the wells.

The value of 28 °C is a default setting of the embedded controller. 

note  If you use the DanioVision TCU, follow the instructions in the 
section The DanioVision Temperature Control Unit on page 76 and set 
the switch to either On or Off.

Off

The anti-condensation mechanism is permanently turned off. Use this 
mode when the air temperature inside the chamber is equal to or 
higher than the actual water temperature of the basin/well plate 
water (in most cases 28 °C). You can use this option in combination 
with the DanioVision TCU.

On

The anti-condensation mechanism is permanently turned on. Use this 
mode when the air temperature inside the chamber is lower than the 
water temperature in the wells. You can use this option in combination 
with the DanioVision TCU.

configure the daniovision white light

In the DanioVision Observation Chamber it is possible to use very low 
light levels for the DanioVision White Light in addition to the default, 
standard white light levels. The standard light levels range from ±20 lux 
to ±10000 lux. The low light levels range from 0 to ± 20 lux.

Both standard and low light can be controlled in the same way by 
EthoVision XT’s Trial and Hardware Control. 

1. Locate the switch, behind the camera, at the bottom-left of the 
black mini USB-IO Box.
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2. Set the intensity of the White light.
- Right position H, standard high light level.

- Left position L, low light level.

place well plates and petri dishes

Well plates (ANSI standard)

1. Put the back of the well plate against the bridge and place it on the 
basin floor.
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2. Tilt the front of the well plate down to the floor. This way the water 
in the basin pushes the air from underneath the well plate. Make 
sure the well plate is accommodated correctly between the metal 
springs at the front and at the right side.

tip  Drill a few holes on the sides of the well plate to allow air to 
escape when placing the well plate.

Well plates (non-ANSI standard)

For smaller or larger well plates, place the bridge in a different position. 
The default position (ANSI standard) corresponds to the second hole on 
the side walls of the basin, when counting from the inner side of the 
observation chamber.

1. Remove the screws as indicated in the picture.
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2. Slide the bridge by one or more positions. 

Check the video image in EthoVision XT, and make sure that the 
well plate is centered in the camera view. 

3. Fix the screws in the corresponding holes.

Petri dishes

1. Put the Petri dish against the 90º angle of the bridge.
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2. If necessary, remove the screws of the bridge (see above) and slide 
the bridge of a few positions until the dish is centered in the camera 
view.

With DanioVision you can use Petri dish of diameter up to 90 mm.

We recommend not to let water flow in the basin when using Petri 
dishes. Water may flow underneath the bottom of the dish, making it 
shift from its original position during a trial.

control evaporation

Wells on the sides of the well plate tend to show a higher rate of 
evaporation than wells in the center. Also, wells at the front have a 
higher evaporation rate than those at the back.

Our recommendations

In long experiments (> 24 h), evaporation may occur for both the wells 
in the plate and the basin. 

 Wells: Check the wells every 24 hours and if necessary, refill them.

 Basin: Refill the basin every 2-3 days using the Basin Refill tool. For 
details, see the page 97.

The environmental conditions (temperature, relative humidity and air 
flow) and experimental conditions (lens heater on/off, White light 
intensity) influence the rate of evaporation (and condensation) of 
water from the basin and well plate. If you plan to carry out long 
experiments, always test evaporation at your environmental and 
experimental conditions, and plan refills to make sure that water drop 
never reaches a critical value.

tip  You can use a special syringe to refill the basin without having to 
open the DanioVision Observation Chamber. Contact Noldus for more 
information.
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5 Set up EthoVision XT

prerequisites

Before you can start working with the DanioVision system, you need to 
connect the DanioVision Observation Chamber to the EthoVision XT 
computer (see page 16) and, optionally, set up the water-flow system 
(see page 19). After you have turned on the DanioVision Observation 
Chamber with the switch on the front panel, wait at least 15 minutes 
for the DanioVision chamber to ‘start up’.

Also make sure to remove the lens cap from the camera.

Assign treatments to wells

To prevent systematic errors as a result of potential variation in 
temperature, light intensity or other unknown variable across a well-
plate, it is recommended to either assign larvae from different 
treatments randomly to the wells or make sure that wells containing 
different treatments (that is, different solutions or different 
concentrations of the same solution) are evenly distributed across the 
well-plate (so, for example, one type of solution is not only put in the 
center wells).

create a daniovision experiment

Preferred method

With this method, All arenas are created automatically, but need to be 
manually adjusted, using the Arrange Arenas option. Unnecessary 
functionality like manual scoring is removed from the interface and 
detection settings are optimized for DanioVision. 

If you select a template which contains more arenas than needed, you 
can exclude the unused arenas with Data selection (see page 153).

After you have followed the steps below to create the new experiment, 
you must still check/adjust Experiment Settings, Arena Settings and 
Detection Settings before you can track any animal correctly.
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1. Do one of the following:
- In the EthoVision XT Startup window, under New experiment, 

click New from template.

- Choose File > New from Template.

2. In the Select a template option window, click Apply a pre-defined 
template. Next, follow the instructions in the guided setup as 
described below.

3. Which video source will you use?

Select the option Live tracking (and saving video files), click the 
Sources button and select the Basler camera. Click Next >.

4. Which subjects will you track?

Select Fish and then Zebrafish larvae from the list. Click Next >.

5. How is the arena configured?

Select an Arena template from the list, then click Next >.

- DanioVision DVOC 004x, 24 round wells.

- DanioVision DVOC 004x, 48 round wells.

- DanioVision DVOC 004x, 48 square wells.

- DanioVision DVOC 004x, 96 round wells.

- DanioVision DVOC 004x, 96 round wells.

- DanioVision DVOC 004x/T, 24 round wells. *

- DanioVision DVOC 004x/T, 48 round wells.

- DanioVision DVOC 004x/T, 48 square wells.

- DanioVision DVOC 004x/T, 96 round wells.

- DanioVision DVOC 004x/T, 96 round wells.

*) Select one of the options with /T when you have installed the 
DanioVision Tapping Device and you want to use it in this 
experiment. For details see page 113.

tip  To know which DVOC version you have, 
see the serial number on the label located 
on the back panel.

- Open field, round.

- Open field, square.
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- Well plate, round wells - Select this option if you have a 
different number of round wells.

- Well plate, square wells - Select this option if you have a 
different number of square wells.

note  Arena templates are also present for older DanioVision DVOC 
versions: DVOC 001x to DVOC 003x.

note  If you selected a template for an older DanioVision version, it 
is possible that the DanioVision detection method does not give 
optimal detection of the larvae with images from your camera. If 
that is the case, try to change the Sensitivity or use another 
detection method in the Advanced section of the Detection 
Settings pane. See also Configure Detection Settings in the 
EthoVision XT Help.

6. Initialize template experiment. Check here that all settings are 
correct and, if so, click Finish.

7. Enter the name of the experiment and click OK.

The EthoVision XT Overview window opens.

8. Follow all the next steps:
- Experiment Settings. See page 46.

- Arena Settings. See page 50. 

- Trial Control Settings. See page 58.

- Detection Settings. See page 66.

Other ways to create a DanioVision experiment

 Create an experiment based on a previous experiment. For example 
when you want to replicate an experiment with the same number 
of arenas, the same trial control procedures, etc.

Choose File > New from Template > Apply a custom template.

For details, see Create a new experiment based on an existing 
experiment in the EthoVision XT Help.

 Create a DanioVision experiment with no predefined settings. With 
this option you have to draw the arenas and arrange them 
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manually. Instead, we advise to create an experiment with a 
predefined template (page 42), because all arenas are then defined 
automatically.

Choose File > New and in the window that appears select the 
option DanioVision experiment. 

In the Experiment Settings, next to Number of Arenas enter the 
number of wells.

Notes

 For more information on creating an experiment manually, see Set 
Up an Experiment in the EthoVision XT Help. 

 No matter which method you choose, when you create a 
DanioVision experiment unnecessary functionality like the Manual 
Scoring Settings is removed from the interface and detection 
settings are optimized for DanioVision.
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experiment settings

Choose Setup > Experiment Settings.

Video Source

1. Under Video source, click the Video icon on the right 
side of the row of your camera. 

2. In the Video Settings window that appears, click the Formats tab 
and select the Resolution and Frame rate. Default resolution is 1280 
x 960 at 30 frames/s.

If you create an experiment based on a template with the Tapping 
Device, set the frame rate to 60 fps and reduce the resolution 
according to your setup (see the table on page 30). 
See also the guidelines in columns G, H and I in Table 1 on page 30.

From the Color space list, choose Y800. This is the color space for a 
monochrome video image. The other options, suitable for color 
images, do not apply to DanioVision.
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Tracked Features

Specify whether you want to track the center point of the fish (default) 
or the center point, the nose point and the tail base. Choose the latter 
option only if you track fish in a close-up image. 

Body Point Detection Technique

The Contour-based technique is selected. The option Deep learning is 
not available in DanioVision experiments.

Analysis Options

If you are interested in how long and how frequent your subjects have 
been active vs. inactive, under Analysis Options select Activity analysis. 
Make sure you also adjust the Activity settings in the Detection 
Settings (see page 69).

For more information about setting up an experiment, see Set Up an 
Experiment in the EthoVision XT Help.

use of trial control hardware

Follow this section if you use stimulus devices like the white/color 
lights and the tapping stimulus device.

1. In the Experiment Settings, under Trial Control Hardware, make 
sure that Use of Trial Control hardware is selected and click the 
Settings button.

2. In the Hardware Interface window that opens, choose the type of 
system you have.

If you have DanioVision DVOC-0041:

- Choose DanioVision DVOC-004x/T if you use the Tapping Device 
in this experiment.

- In all other cases choose DanioVision DVOC-004x. 
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The other options DanioVision DVOC-001x - 003x are meant for 
older versions of the DanioVision Observation Chamber.

note  The option Mini USB-IO Box only applies when you use a Mini 
USB-IO box instead of DanioVision DVOC.

3. In the Device Configuration window, under Device features, the 
hardware devices activated for this experiment are listed.

4. optional  The default status of the DanioVision White Light 
Stimulus if Light off. This means that, when you start a trial, the 
white light is switched off. To use the white light as a stimulus, 
program its activation with Trial Control. If, however, you want to 
use the white light as a default lighting condition, and use the 
darkness as a stimulus, do the following:

a Click the White Light Default button. 

b Under Default device state, select Light on.

c Choose a percentage of intensity (0-100) and click OK.
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Then in the Trial Control procedure you can program when to 
switch the light off. See Trial Control Settings on page 58.

5. optional  If you connect additional hardware, under Plug-in devices, 
select the devices in the corresponding rows for TTL Port 1-4, or 
Expansion 1 / Port 1-4 depending on which port on the DanioVision 
back panel you use.

6. Click OK.

7. optional  If you set the default state of the White Light Stimulus to 
Light on, open the Trial Control Settings. This will confirm your 
selection.

Notes

 The Tapping Stimulus is listed under Device features when you 
select DanioVision DVOC-004x/T in step 2.

 If you upgraded from an older version of EthoVision XT, and you use 
an experiment created in the older version as a template for a new 
one, the DanioVision detection method is not available. Therefore, 
we recommend to create a new experiment with the newest 
version, and use this as a template (File > New From Template > Use 
a custom template).

 If you upgraded an experiment from an older EthoVision XT version, 
do not change the Trial Control Hardware Settings in the 
Experiment Settings. Leave Noldus Mini USB-IO Box selected in the 
Hardware Interface window. Otherwise the Trial Control rules, for 
example to control the white light, may not work. 

 When you change the default state of the White Light Stimulus to 
Light on, note that the white light is only switched on in one of the 
following cases:

- When you open the Trial Control screen.

- When you open the Arena - Hardware Mapping window.

- When you start a trial.

 For more information on Trial and Hardware Control, see the 
EthoVision XT 18 - Trial and Hardware Control - Reference Manual.
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6 Arena Settings

define the arenas

Choose Setup > Arena Settings > Arena Settings 1.

To define the arenas automatically

Follow these instructions if your experiment was created for well 
plates with 6, 12, 24, 48 or 96 round wells, or 96 square wells, and this is 
the first new Arena Settings in your experiment. In other cases, go to To 
define the arenas manually on page 52.

tip  Use well plates with no notches between wells. These result in 
better well detection. Also make sure that the borders of all wells are 
within the camera image.

1. In the Grab Background Image window, click the Grab button to 
grab a background image of an empty well-plate from the camera 
image.

2. If EthoVision XT can detect the wells, the outline of the arenas are 
displayed over the background image. A message appears asking 
whether the arenas overlap with the wells in the image.
50  6 - Arena Settings



3. Do one of the following:
- If there is good overlap like in the picture below, click Yes. 

If needed, you can always make small adjustments using the 
Arrange Arenas function (see page 54).

- If the arenas clearly do not overlap with the wells, or arenas 
overlap with each other, click No. The Arrange Arenas window 
appears automatically. See arrange the arenas on page 54 for 
details.

4. Click the 1. Draw Scale to Calibrate button.

Draw a line over the entire well-plate. Next, enter its size. Do this 
horizontally as well as vertically.

5. Click Validate Setup to validate the Arena Settings. Common errors 
are overlapping arenas, or zones falling outside an arena. If the 
setup is valid, continue with the instructions below. 

Notes

 Arenas are marked with labels A1, A2,... B1, B2,... according to your 
well plate (letters indicate rows; numbers indicate columns)

 Automatic detection of the wells in the video image has been 
tested with the DVOC-0040 and DVOC-0041. Success of automatic 
detection much depends on image contrast, focus, and distortion, 
and therefore we cannot guarantee it will work in all situations and 
with video made with previous DanioVision versions. Automatic 
detection also does not work if water is not present in the well 
plate.
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 If automatic detection of the wells does not work, it could be due to 
the well plate being not centered in the video image.

See Fine camera adjustments on page 172.

 When the well plate image is optimal and centered, and still 
EthoVision XT shows the message Well plate detection failed, click 
OK and proceed with To define the arenas manually on page 52.

 To start automatic well plate detection, click the Well plate 
detection button  at the bottom of the Arenas and Zones 
section of the Arena Settings pane.

To define the arenas manually

The following instructions apply when the automatic well plate 
detection does not work properly. In that case you must define one 
arena and then make duplicates.

If you used a predefined template to set up your experiments, go to 
arrange the arenas on page 54.

1. Click the 1. Draw Scale to Calibrate button, draw a line over the 
entire well-plate and enter its size. Do this horizontally as well as 
vertically.
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2. If the current arenas are of shape different from that of the wells, 
select all arenas and press Delete.

3. Click 2. Select Shape and Draw Arena and use one of the shapes to 
create the first, top-left, arena. Make sure the label of the first arena 
(for example A1) points to the inside of the drawn arena. 

4. Click the outline of the arena or its label and then click the 4. Copy 
Arena button.

In the window that appears select All other arenas. Select the 
number of rows and click OK.

5.  Make sure the predefined arenas cover the wells. If you need to 
adjust the arena size and position, see arrange the arenas on page 
54. 
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arrange the arenas

1. in the Arena Settings window, click the 5. Arrange Arenas button. 

In the Arrange Arenas window, do the following:

2. To move all arenas: Under 1. Move Grid

To move up/down: Click the first slider. Move it the right (to move 
the arenas down) or left (to the arenas move up).

To move to the right/left: Click the second slider. Move it the right 
(to move arenas to the right) or left (to move them to the left).

You can also click the up/down arrow buttons of the corresponding 
box or enter a number in the box.

3. To scale all arenas: Under 2. Scale Arenas

Resize all shapes by using the sliders, by pressing the up/down 
arrows of the corresponding box or by entering a number in a box.

To increase the height of all arenas, use the first slider. To increase 
the width of all arenas, use the second slider

By default the option Keep proportions is not selected. Then you 
can resize the height and width of all shapes separately. If you 
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select Keep proportions, you can change either the height, or the 
width while keeping the aspect ratio. 

4. To rotate all arenas: Under 3. Rotate Grid

Optionally, rotate all shapes. This is only necessary if the well-plate 
is not positioned straight. The shapes rotate around the center of 
gravity of Arena 1.

5. To change the space between arenas: Under 4. Arena Spacing

Change the space between the shapes.

By default, the option Keep proportions is not selected. Then you 
can change the space between the shapes separately in the vertical 
and horizontal direction (relative to the first row and first column, 
respectively). If you select Keep proportions, change the spacing in 
either the horizontal or vertical direction while keeping the aspect 
ratio. 

tip  First position the upper left arena in the desired position and 
make desired size (use scale). Next adjust arena spacing so all 
arenas are correctly positioned. See Using the Multiple Arena Setup 
in the EthoVision XT Help for information on setting up multiple 
arenas.

6. Click Validate Setup to validate the Arena Settings. Common errors 
are overlapping arenas, or zones falling outside an arena. If the 
setup is valid, continue with the instructions below. 
6 - Arena Settings 55



To edit a single arena

Click the row in the Arena Settings pane for that arena.

The corresponding arena is highlighted. Click the handles and move or 
resize the polygon.

For details on editing shapes, in the EthoVision XT Help see Arena 
Settings > Work with shapes.

assign the stimuli to the arenas

Follow this procedure if you want to apply stimuli during a trial, for 
example a light pulse or a tapping stimulus.

important If you created an experiment with a pre-defined template 
and selected the correct DanioVision arena template, the White Light, 
or Tapping Stimulus has been assigned automatically to the arenas. 
The steps below are then not necessary. 

1. At the bottom of the Arena Settings pane, click the Arena - 
Hardware Mapping button.
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2. In the Arena - Hardware Mapping window, do one or both 
depending on what you want to use:

a Click Add device. Under Arena 1, select White Light Stimulus.

a Click Add device. Under Arena 1, select Tapping Stimulus.

The devices White Light Stimulus and Tapping Stimulus only need 
to be assigned to Arena 1. They are in fact applied to all arenas.

3. Click OK.

For more information

  See also Test the hardware devices in the EthoVision XT 18 - Trial 
and Hardware Control - Reference Manual.

 To set up the Tapping Device, see also The DanioVision Tapping 
Device on page 113.
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7 Trial Control Settings

default trial control settings

Choose Setup > Trial Control Settings > Default or White Light Routine.

The template experiment contains two examples of trial control 
settings:

 Default - The default Trial Control Start-Stop rule. Use these 
settings to start and stop tracking manually.

 White Light routine. Use these settings when you want to provide a 
light stimulus during the trial. Ten minutes after the start of the 
trial, the DanioVision white light immediately turns on to 100% 
intensity for 10 minutes, then the white light immediately turns off 
for 10 minutes. This sequence of actions is repeated twice, using a 
sub-rule, after which the trial stops.
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 For using the White Light, see below.

 For using the Tapping Device, see page 113.

Maximum trial duration (recommended)

 If you record video: 60 minutes.

 Without recording video: 72 hours.

You can in principle record video for more than one hour, however 
consider that DanioVision creates high quality video files, which occupy 
a large disk space. Depending on the frame rate and resolution, one 
hour recording may require more than 1 GB.

Set the duration of your trials in the Maximum Trial Duration pane or in 
the Start-Stop trial rule, by placing a Time condition immediately 
before the Stop track action box.

Tested configuration

 Camera video resolution: 1280 x 1024.

 Operating system: Windows 10 Pro, Windows 11 Pro.

 Software: EthoVision XT 18.0.

 Experiment: DanioVision with 96 wells (arenas).

 Trial Control: Two subrules, one for the Tapping device and the 
other for the White light. One Action every five minutes, for 30 
minutes total per device type. Total duration of the test: two hours.
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create your own trial control procedure

You can adjust these trial control settings to your own needs. The 
procedure below describes how to define Trial Control Settings from 
scratch.

For more information on Trial Control Settings:

 The section Trial Control in the EthoVision XT Help.

 The EthoVision XT 18 - Trial and Hardware Control - Reference 
Manual. To open this manual, from the Windows Start menu 
choose All Apps > Noldus > EthoVision XT 18 Other Documentation.

With the Trial Control Settings you can control the DanioVision White 
Light.

Example: After a 24-hour dark period in the DanioVision Observation 
Chamber, you want to expose your animals to alternating periods with 
the white light on and off, in which the light-on periods also vary in 
intensity. This schedule is shown in the figure below.

To program this schedule:

1. To open the Trial Control, in the Experiment Explorer, right-click 
Trial Control Settings, select New, enter a name and click OK.

The Trial Control screen opens with the default Start-Stop trial 
control rule.

2. Click the Condition Time box with “Infinite time” and press Delete.
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3. In the Components pane, under Actions - Hardware, click the button 
in the Add column next to White Light Stimulus. Select Create a new 
action.

4. In the Hardware Action window, set the following:

- Action name. Enter a description of the action, for example 
“Light on 100%”.

- Action to perform. Select Light on from the list.

- Intensity level. Select the maximum intensity level of the light, 
in percentage (0 - 100%) or in Steps (0-4096). See some 
reference values on page 181.

- Fade duration. For example, with Intensity level of 50% and a 
Fade duration of 2 seconds, the white light gradually turns on 
until 50% of its maximum intensity in 2 seconds time.

note  If your experiment was created from a template of 
EthoVision XT 17.0 or an earlier version, you could only set the 
fade duration in seconds. In the experiments created from 
templates in EthoVision XT 17.5 and later versions, you can set 
the fade duration in milliseconds, seconds, minutes and hours 
(up to 24 hours).

5. Click OK and insert the Action box in the sequence.

6. In the Components pane, under Conditions, click the button next to 
Time. Click Create a new action and click OK. 

In the Time condition window, you can set the following:

- Condition name. For example, enter ‘Wait 15 mins’.

- Condition is met. For the option After a time of, enter ‘15 mins’.
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7. Click OK and insert the Condition box in the sequence.

8. Repeat steps 3-6 to complete the Trial Control rule example 
described on page 60:
- Add an Hardware Action box with White Light - Off and a 

Condition Time box with “After 10 mins”.

- Add an Hardware Action box with White Light - On 50% and a 
Condition Time box with “After 10 mins”.

- Add an Hardware Action box with White Light - Off and a 
Condition Time box with “After 10 mins”.

- Add an Hardware Action box with White Light - On 100% and a 
Condition Time box with “After 15 mins”.

tip  Combinations of Action and Condition boxes that are repeated 
in a sequence can be replaced with a sub-rule. This is especially 
handy when the entire sequence is repeated multiple times during 
a trial. For example: [White Light - On - 100%] > [After 10 min] > 
[White Light - Off] > [After 10 min]...

For more information on using sub-rules, see also the EthoVision XT 
18 - Trial and Hardware Control - Reference Manual.

Figure 11  This combination of Action and Condition box turns the White 
Light on at 100% intensity and keeps it on for 15 minutes.
62  7 - Trial Control Settings



9. Insert all the boxes in the correct order into the sequence and make 
sure you connect all boxes (see Figure 12 and Figure 13 on the next 
page for an example).

Figure 12  Example of Trial Control Settings. This is the first half of the Start-Stop 
Trial rule. In this example of Trial Control Settings, the repeated combination of 
Action box ‘Light off - 0’ and Condition box ‘Wait 10 mins’ to turn the White Light 
off for 10 minutes, has been replaced by a Sub-rule (see also the Figure on the 
previous page).

Figure 13  Continued from Figure 12. This is the second half of the Start-Stop Trial 
rule. The Sub-rule is called a second time by the Reference box Light off (2).
7 - Trial Control Settings 63



Notes

 Click Test in the Hardware Action window to test the hardware 
action.

 Click Reset to reset all Hardware Action windows in your Trial 
Control procedure to their default values (for example a White Light 
action is set to off; however if you set the default White light to on 
(page 48), then after clicking Reset the White light switches on.

 To analyze data in the light or dark period, create first a Data profile 
that specifies that period using Trial Control State (see page 154). 
Then, calculate the statistics.

Use an external command

If you want to use an external command, for instance to play a sound 
during the trial, the command is executed for each arena. For example, 
the command to play the sound is repeated 96 times for a 96 arena 
experiment. To prevent this from happening:

 Insert a condition before the External command box, which will 
only become true for one of the arenas, for example Arena 1.

 In the Arena Settings, create a zone in Arena 1 and call it “Zone 1A”. 
Make the zone as large as the arena. In the Trial Control Settings, 
make a condition like “Is subject in Zone 1A?”, followed by the 
external command. 

 Make sure that the sequence does not interfere with the rest of the 
Trial Control rule. In the example of the next figure, the Condition 
box and the external command Action box have been placed in a 
separate branch. This way the execution of the external command 
does not influence the other actions in your trial control procedure.
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8 Detection Settings

What do you want to do?

 Track one subject per well/enclosure. See below.

 Track two or more subjects in the same enclosure. See page 70.

 Use Activity. See page 69.

one subject per enclosure

Choose Setup > Detection Settings > Detection Settings 1.

The DanioVision detection method

The template experiment contains a Detection Settings profile with 
DanioVision selected as method.

The DanioVision detection method is optimized for detecting small 
dark objects over a white/gray background, like in DanioVision 
experiments. Its main features are:
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 The difference with other methods is that DanioVision detects the 
subject based on the level of contrast within the well where the 
subject is. So you can view this method as Dynamic Subtraction 
applied to each well independently. This method should detect all 
subjects even when there are differences in lighting between wells.

 This method does use a reference image, just like Dynamic 
Subtraction, however you do not have to choose one. The software 
does that for you by taking the first video frame available. 

 After comparing the reference image with the current video image, 
DanioVision selects the pixels within the well that are more likely 
to be part of the subject. How “choosy” the software is depends on 
the Sensitivity. With a low value of Sensitivity the software 
considers pixels over a wider range of grey values as candidates. 
With high values, it picks pixels over a narrow range of grey values 
(see below).

 If some subjects are completely still, the software may not find 
them. If that occurs, gently tap the well plate to make the animals 
move. Once all the subjects are detected, adjust your settings.

important  If you have upgraded EthoVision XT to version 18 while you 
have a DanioVision system older than the DVOC-0040, the 
DanioVision method does not give optimal detection of the larvae with 
images from your camera. If that is the case, adjust the Sensitivity (see 
below) or use another detection method in the Advanced section of 
the Detection Settings pane. For details, see the EthoVision XT Help.

Procedure

1. Place the well plate with the larvae in the DanioVision chamber 
and close the chamber door.

2. Click the Auto-detect button.
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important Use the Auto-detect button every time you change a 
well-plate.

3. The Auto-detect window with a timer appears. Wait until it has 
disappeared. All larvae should be detected well, like in this example:

What if some larvae are not detected or the software tracks noise?

Do one or more of the following:

 Open the Advanced section and under Method move the 
Sensitivity slider. Moving the slider to the left results in detecting 
more of the body of the larvae, but also more noise. Moving the 
slider to the right results in detecting less noise, but also gives less 
good detection of the larvae.

 If you see erratic tracks and spikes like that in the picture below 
(right), it means that small groups of pixels at the border of the well 
are sometimes detected as the larva. There is also too much noise 
(orange pixels). Move the Sensitivity slider to the right.

 If some larvae are not detected while they are in the corner or 
border of a well, check that the arenas are drawn well. Click the 
Show/Hide button on the toolbar and select Arena Features and 
then select the check box in front of Arenas.
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Check that the arenas cover the entire wells. In the picture below, 
the arena on the right does not cover the left margin of the well.

The subject is not detected when it swims in that region.

 Try to maximize the contrast by opening the aperture of the camera 
lens (See “check the camera lens” on page 34.) However, make sure 
the light intensity is equal for all wells (that is, the center and outer 
wells).

 Certain compounds dissolved in the water can affect the 
pigmentation in the larvae, thereby decreasing the contrast of the 
animal and making detection of the animal more difficult. Make 
sure that EthoVision XT can still detect all animals after treatment.

 If detection remains unsatisfactory:

- It could be that the software tracks other objects outside the 
well. Restrict the arenas only to the part where the larvae swim.

- Try the Dynamic subtraction method. For an explanation of the 
options, see Configure Detection Settings in the EthoVision XT 
Help.

activity analysis

Use Activity to quantify overall activity of your subjects. In the 
Experiment Settings (see page 47) select Activity analysis. In the 
Detection Settings pane, open the Activity section. Activity is shown by 
purple pixels in the video window. Set the Activity threshold in such a 
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way that movements of the animals are detected and some noise is 
left.

For more information on activity, see Activity settings in the EthoVision 
XT Help. Also watch the video tutorial on Activity analysis.

For more general information on Detection Settings, see Configure 
Detection Settings in the EthoVision XT Help.

multiple subjects in the same enclosure

Prerequisites

in the Experiment Settings, Number of Subjects is set to 2 or higher.

Procedure

1. Choose Setup > Detection Settings > Detection Settings 1.

2. Click Automated Setup. One subject is detected per well. Play the 
video to check detection. 

3. Click Advanced, then Method, select DanioVision.

An example of multiple larvae being tracked with this method:

Note that the subjects are not individually marked, so identity swaps 
do occur.
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Notes

The method Dynamic Subtraction may also work fine with zebrafish 
larvae. In that case:

 If your experiment is set to track the three body points (snout, 
center and tail), you can choose the Adult fish/For Occlusions 
method.

 If the experiment is set to Center-point detection only, choose 
either DanioVision or Dynamic Subtraction, with the Other species 
method to track the center point of the subjects.
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9 Acquire data

There are three ways of acquiring data with your DanioVision system. 
For every option it is possible run single trials, but it is also possible to 
carry out batch acquisition. 

 acquire data live (page 73). The larvae are tracked as they move in 
their wells.

 acquire data live and record video simultaneously (page 74). 
The larvae are tracked as they move in their wells while at the same 
time a video is recorded. This gives you to opportunity to redo the 
tracking if necessary, either per trial or using batch acquisition.

 record video, then acquire data (page 75). You record a video first 
and then track the subjects offline from the video. Please note that 
if you only record video with EthoVision XT, Trial Control is not 
applied. So, for example, the white light is not switched on and off, 
if you only record video.

Before you start acquiring data, make sure you have carried out all the 
necessary checks of the system (see page 33).

Notes

 The DanioVision Observation Chamber is designed to block light 
from the outside. However, it cannot be guaranteed that it is 
completely dark inside the chamber. For experiments that require 
absolute darkness, place the DVOC in a dark room.

 important  In long experiments, evaporation may occur for both 
the wells in the plate and the basin. Check the wells every 24 hours 
and if necessary, refill them.

Refill the basin every 2-3 days using the Basin Refill tool. For details, 
see page 97.

 Please read the section in the next pages that applies to your setup. 
For more information, see Acquire Data in the EthoVision XT Help.
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acquire data live

1. Make sure the camera is connected to the EthoVision XT computer 
and that Live tracking is selected as Video Source in the Experiment 
Settings.

2. Optionally, plan your trials in the Trial list and select the Arena 
settings, Detection settings and Trial control settings for each trial. 

3. Choose Acquisition > Open Acquisition.

4. If no trials are planned, click the New trial button in the Playback 
Control window or press Ctrl+F3.

5. In the Acquisition Settings pane, select whether you want to track 
only the next planned trial or whether you want to track all planned 
trials without having to start the next trial manually.

If you want to track all planned trials, specify the inter-trial interval. 
Enter a time long enough to be able to change well plates. When 
you change the well plate between trials, you can start the next 
trial without waiting that the inter-trial interval is reached. To do 
this, click the Skip remaining interval button in the Playback 
Control window.

 

6. Select whether you automatically want to start the analysis after 
the tracks are acquired. If that is the case, first define your 
dependent variables in an Analysis Profile (see Analyze the data on 
page 160). Optionally, first make a Track Smoothing profile and a 
Data profile to make a selection out of your data. 

7. Select whether you want to use the Track smoothing profile, Data 
profile, and Analysis profile that are highlighted in blue in the 
Experiment Explorer for analysis, or that you want to run analyses 
for all possible profile combinations. In the latter case, first delete all 
profiles you do not need for analysis. If you want to carry out 
analyses for only a selection of profiles, deselect the check box Auto-
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start analysis and carry out batch analysis after acquisition (see step 
5 on page 164).

8. Put the well-plate into the DanioVision chamber.

9. Click the Auto-detect button. A Re-initialize window with a timer 
appears. Wait until it disappears.

important  Use the Auto-detect button every time you change a 
well-plate.

10.To start the trial, click the Start trial button in the Playback Control 
window (or press Ctrl+F5).

11. To stop the trials, wait until Trial Control automatically stops the 
trials. To stop acquisition manually click the Stop trial button in the 
Playback Control window (or press Ctrl+F6). If you stop the trials 
manually, automatic analysis does not start. Also, for batch analysis, 
the next trials are not started if you stop a trial manually.

note  The recommended maximum trial duration when acquiring live 
without recording video is 72 hours (3 days).

acquire data live and record video 
simultaneously

To save video when doing tracking, follow the procedure above, with 
the difference that in step 4 you select the check box Save video in the 
Acquisition Settings pane.

If you realize tracking was not optimal, you can re-do tracking from the 
acquired video.

note  The recommended maximum trial duration when acquiring live 
and recording video simultaneously is 60 minutes. Longer trials 
produce video files of excessive size, more difficult to manage. 
Furthermore, if one large video gets corrupted then you lose more data.
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record video, then acquire data

If you use the option Save video only, track later, Trial Control is not 
applied so you cannot control the white light of the DanioVision 
Chamber with EthoVision XT.

To save video when doing tracking, follow the procedure on page 73, 
with the difference that in step 4 you select Save video only, track later 
in the Acquisition Settings pane. Also make sure that the trial is time 
limited, either with a time condition in the Trial Control start-stop rule, 
or with a Maximum Trial duration setting (page 59).

Next, you can acquire data using batch acquisition. Plan your trials in 
the Trial list and specify the video and optionally Arena Settings, Trial 
Control Settings and Detection Settings for each trial.

note  The recommended maximum trial duration when recording video 
is 60 minutes. Longer video recordings produce files of excessive size, 
more difficult to manage. Furthermore, if one large video gets 
corrupted then you lose more data.

drain and clean the system

At the end of the experiment, we recommend to remove all the water 
from the basin and the tubes.

If you use the Temperature Control Unit, DV-TCU, set it to Fill/Drain and 
follow the instructions in the next section (page 76).

To prevent the growth of algae in the system:

 Always drain the system after use.

 Do not expose the system and the tubes to sunlight.
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10 The DanioVision Temperature 
Control Unit

introduction

The combination of the DanioVision Observation Chamber and the 
Temperature Control Unit allows you to set up a temperature-
controlled water flow underneath the well plate in the DanioVision 
Observation Chamber. The result is a constant temperature in the well-
plate throughout an experiment.

If you are a new DanioVision user, you get a new DanioVision 
Observation Chamber, the Temperature Control Unit and all 
accessories necessary to work with the DanioVision system.

DanioVision users with a DanioVision Observation Chamber purchased 
before 25 January 2013 must upgrade their DanioVision Observation 
Chamber in order to be able to work with the Temperature Control 
Unit. Please contact your Noldus sales representative for more 
information.
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workflow

1. Set up connections.

Connect the DanioVision Temperature Control Unit and the 
Observation Chamber. See page 77.

2. Set up EthoVision XT.

Set up the DanioVision Temperature Control Unit. See page 82.

optional  Configure the temperature alarms in EthoVision XT. See 
page 89.

3. Carry out an experiment.

Acquire data with the DanioVision Observation Chamber and the 
DanioVision Temperature Control Unit. See page 95.

important  After the experiment, drain the DanioVision 
Observation Chamber and the DanioVision Temperature Control 
Unit. Also keep the tubing far from sunlight to prevent algae 
growth inside the tubing. See Drain the system on page 84.

For more information

See the EthoVision XT 18 Help and the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.

connections

important  If you are a user of a DanioVision system with version 
number DVOC-0020/-0021, you need to upgrade your DanioVision 
Observation Chamber to be able to connect the Temperature Control 
Unit. Contact your nearest Noldus office for more information.
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important  Make sure you place the DanioVision Temperature Control 
Unit at the same level as the DanioVision Observation Chamber. If that 
is not possible, place the DanioVision Temperature Control Unit at no 
more than 1.3 m below the DanioVision Observation Chamber.

Accessories

The Temperature Control Unit includes:

 A 1.5 m color-coded drain tube.

note  For connecting the DanioVision Temperature Control Unit, 
you also need the color-coded tubes that come with the 
DanioVision Observation Chamber DVOC-0041.

Figure 14  Basic connections between the DanioVision Observation Chamber and 
the Temperature Control Unit. Arrows indicate the direction of water flow. Colored 
circles indicate the color of connectors.
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 A cable for the temperature sensor with a cinch-plug on both ends.

 A 3-m network (UTP) cable to connect the TTL ports on the 
Temperature Control Unit and the DanioVision Observation 
Chamber.

 Liquid coolant and a funnel to fill up the coolant.

 The Basin Refill Tool, for filling the DanioVision basin with liquid 
without opening the DanioVision Observation Chamber (see page 
97).

 A power adapter GS120A24 and a power cord.

Procedure

1. Connect the tube with the green color code to the connectors with 
the green ring on (see Figure 15 how to connect a tube) both the 
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DanioVision Temperature Control Unit and the Observation 
Chamber (indicated by ‘2’ in Figure 16). This is the tube through 
which water flows into the DanioVision Observation Chamber.

2. Connect the tube with the yellow color code to the connectors with 
the yellow ring on both the DanioVision Temperature Control Unit 
and the Observation Chamber (indicated by ‘1’ in Figure 16). This is 
the tube through which water flows out of the DanioVision 
Observation Chamber. 

3. Connect the tube with the blue color code to the connector with the 
blue ring on the DanioVision Temperature Control Unit (indicated by 
‘3’ in Figure 16). This is the tube to drain the DanioVision system. 
Make sure this tube ends in a sink or container.

4. Connect the tube with the red color code to the connector with the 
red ring on the DanioVision Observation Chamber (indicated by ‘4’ 
in Figure 16). This is the tube for the water overflow of the 
Observation Chamber. 

important  Make sure that the tubes with red and blue color codes 
end in a sink or container, and it is slanted downwards so that water 
flows spontaneously.

5. Connect the cable with the cinch-plugs to the temperature-sensor 
connectors on both the DanioVision Temperature Control Unit and 
Observation Chamber (indicated by ‘5’ in Figure 16). 

Figure 15  How to connect a tube to a TCU connector. 1 - Slide the nut of the 
connector onto the tube, 2 - Connect the tube to the connector, 3 - Screw the nut 
onto the connector.
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6. Optionally, connect the network cable to the TTL port on the 
DanioVision Temperature Control Unit and TTL port 1-4 on the 
Observation Chamber. This allows you to log temperature error 
messages and potentially use these in trial and hardware control in 
EthoVision XT.

Figure 16  The back panels of the DanioVision Observation Chamber (top) and the 
Temperature Control Unit (bottom). The numbers of the connectors / ports are also 
described in the text above.  
Connectors with the same number are connected with the provided tubes with the 
same color-code. 
1 - Yellow connectors for water flow into the Temperature Control Unit and out of 
the Observation Chamber. 2 - Green connectors for water flow out of the 
Temperature Control Unit and into the Observation Chamber. 3 - Drain connector. 4 
- Water overflow connector. 5 - Connectors for the temperature sensor. 6 - TTL 
ports. 7 - Power connection.
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important  If you have the DanioVision Observation Chamber 
version DVOC-0030 or older, you cannot use TTL2, because this port 
is used by the temperature sensor for the lens heater inside the 
observation chamber.

7. Connect the DanioVision Temperature Control Unit to the mains 
socket.

8. Connect the DanioVision Observation Chamber to the EthoVision XT 
computer (see this manual).

set up the daniovision tcu

Fill and drain cycle

Before you start using the system, it is good to make sure that the 
whole water circuit is clean. For these steps you need demineralized or 
distilled water, and a water container or sink.

important  Always drain the system at the end of the experiments.

1 - Fill the system

1. Turn on the DanioVision Observation Chamber.

On the DanioVision Temperature Control Unit, switch the 
Operation mode to Fill/Drain.

2. Turn the Drain tap completely to Closed.
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Water will flow as depicted in this scheme:

3. Slowly start pouring water into the basin of the DanioVision 
Observation Chamber.

important  Stop adding water when the water level reaches the 
edge of the basin indicated in red in the figure below).
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As a result, the water starts flowing through the tubes. Pour more 
water a few times, until all bubbles in the tubes have gone and the 
basin is completely filled.

2 - Drain the system

1. Keep the Operation switch to Fill/Drain and turn the Drain tap to 
Open. Water will flow as depicted here:

2. When the basin is empty, turn the Drain tap to Closed to remove all 
remaining water from the tubes and let it flow into the basin.

3. Turn the Drain tap to Open again, to completely drain the 
DanioVision Observation Chamber.
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Normal use with set water temperature

1. Turn on the DanioVision Observation Chamber. 

important  After you turned on the Observation Chamber, wait at 
least 15 minutes before you start an experiment in EthoVision XT.

2. Open the DanioVision Observation Chamber, and locate the Anti-
Moisture switch inside the chamber, at the right of the camera (see 
below). Set the switch in one of the two modes.
- On. Choose this when the room temperature is lower than the 

desired water temperature.

- Off. Choose this when the room temperature is higher than the 
desired water temperature.

3. On the DanioVision Temperature Control Unit, switch the Operation 
mode to Fill/Drain.

4. Turn the Drain tap completely to Closed.
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Water will flow as depicted here:

5. Slowly start pouring water into the basin of the DanioVision 
Observation Chamber. 

important  Stop adding water when the water level reaches the 
edge of the basin indicated in red in the figure below).

important  We strongly recommend to use demineralized or 
distilled water to minimize contamination of the system and the 
accumulation of calcium and salt.

As a result, the water starts flowing through the tubes. Pour more 
water a few times, until all bubbles in the tubes have gone and the 
basin is completely filled.
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6. Close the DanioVision Observation Chamber before you set the 
desired temperature in the next steps.

7. Set the Operation switch to On. 

8. Next to the temperature display, hold the Set button for about 1 
second; the display flashes displaying the currently set temperature. 

9. Use the arrow keys to set the desired temperature. 

10.Confirm by pressing the Set button once. 

important  If the difference between the actual and set water 
temperature is more than 0.5 °Celsius / 0.9 °Fahrenheit, an error 
code appears (see feedback and error messages on page 104 for 
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more information). This error message disappears as soon as the 
water temperature is within a 0.5 °C / 0.9 °F range of the set value 
again.

11. Wait until the set temperature has been reached. This takes on 
average 10 minutes, depending on the set temperature and the 
temperature in the room. During this process, the status indicated 
by the LED lights at the front is on Heating / Cooling. Once the 
temperature is stable at the set value, the status changes to Ready.

The DanioVision Temperature Control unit is now ready to start an 
experiment. Make sure that the DanioVision Observation Chamber has 
been on for at least 15 minutes.

Displaying Celsius or Fahrenheit

You can choose to display the temperature in °Celsius or Fahrenheit. To 
set the display to Celsius or Fahrenheit, do the following:

1. Set the Operation switch to On.

2. Keep the Prg and Set button both pressed until the entry code 0 
appears on the temperature display.
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3. Use the arrow keys to change the entry code to 77 and press Set. 

Result: Program c0 appears on the display.

4. Use the arrow keys to go to program c18 and press Set.

5. Use the arrow keys to set the temperature unit to Celsius = 0 or 
Fahrenheit = 1 and press Set to confirm.

6. Keep the Prg button pressed until you exit the program mode.

optional: temperature alarm

Aim

To log the high and low temperature alarm in EthoVision XT. You can 
use the temperature alarm:

 in the Trial Control Settings, for example to stop the trial if the 
temperature alarm lasts for more than a certain time. See page 92.

 In the Analysis profiles, to visualize when an alarm occurred 
together with the data. See an example on page 94.

 As a hardware log, which you can export. See page 95.

note  A temperature alarm should not happen if the TCU is in status 
“Ready”. An alarm is therefore an unusual event in normal conditions. 
If the TCU is still in “Heating” or “Cooling” status, it is normal that a 
couple of temperature alarm occur.

Cable connections
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Connect the network cable to the TTL port in the DanioVision 
Temperature Control Unit and one of the TTL ports 1-4 in the 
Observation Chamber.

important  If you have the DanioVision Observation Chamber DVOC-
0030 or older, connect the TTL port of the Temperature Control Unit to 
TTL ports 3 or 4 on the Observation Chamber. Do not use TTL port 2! 

Define the temperature alarm in EthoVision XT

1. In EthoVision XT, create a DanioVision experiment. For details, see 
page 42.

2. In the Experiment Settings, under Trial Control Hardware, click the 
Settings button. Select the version number of your DanioVision 
Observation Chamber (usually DVOC-004x or DVOC-004x/T if you 
have the DanioVision Tapping Device) and click OK.

3. In the Device Configuration window, under Plug-in devices, choose 
the TTL port that you used to connect the Temperature Control Unit 
(see above). 

Under Device type select DanioVision TCU (DVTCU-001x). Under 
Device ID type in a name or accept the default name DanioVision 
TCU (DVTCU-001x) 1. Next, click OK.
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4. Choose Setup > Arena Settings > Open and choose the Arena 
Settings you use in the experiment. In the Arena Settings window, 
click the Arena - Hardware mapping button. 

5. In the Arena - Hardware Mapping window, click the Add device 
button. Under Device type select DanioVision TCU (DVTCU-001x). 
Under Device name enter a name, for example “TCU Temp alarm”. In 
the column A1 select the Device ID that you defined above.

6. Click OK. EthoVision XT is now ready to log the alarm signals from 
the TCU.

Possible alarm signals

The following TTL signals are sent to EthoVision XT and can be used as 
usual in the Trial Control Settings and Analysis Profiles:

 When the current water temperature is within the normal 
temperature range, that is, a temperature that deviates by less than 
0.5 °C from the set temperature: [Tset -0.5°C  Tcurrent  Tset+0.5°C), 
no alarm is given. Both Low temp error state and High temp error 
state are false. 

 When the current water temperature is more than 0.5 °C lower 
than the set temperature (Tcurrent < Tset -0.5°C), a ‘low-temperature 
alarm’ is given and Low temp error state becomes true.
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 When the actual water temperature is more than 0.5 °C higher than 
the set temperature (Tcurrent > Tset +0.5°C), a ‘high-temperature 
alarm’ is given and High temp error state becomes true.

 When you turn off the Temperature Control Unit or unplug the 
network cable from the TTL port, both Low temp error state and 
High temp error state become true.

note  During a temperature alarm, the TCU tries to bring the 
temperature back to the normal range, so you do not need to take any 
particular action.

The temperature alarm in the Trial Control Settings

Use a temperature alarm in the Trial Control Settings for example to 
stop tracking or start an external program when a temperature alarm 
occurs. Here it is described how to make conditions based on the 
temperature.

note  During a temperature alarm, the TCU tries to bring the 
temperature back to the normal range, so you do not need to take any 
particular action with Trial Control.

prerequisite  You have defined the temperature alarm in EthoVision XT 
(page 89).

1. Choose Setup > Trial Control Settings > Open (an existing profile) or 
New to create a new profile.

2. In the Trial Control Settings, under Conditions click the button next 
to DanioVision TCU (DVTCU-001x).
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3. The Hardware Condition window appears. In the Condition name 
field, enter a name for the condition (for example, “TCU Low Temp 
alarm”).

4. From the DanioVision TCU list select the device name that you 
defined in the Arena - Hardware Mapping window (“TCU Temp 
alarm”, in the example above).

5. Choose the following, depending on when an action should be 
taken:
- To take an action when an alarm occurs, next to Signal to check 

choose either Low temp error state? or High temp error state? 
depending on the alarm you want to use. Then next to Signal 
value select true.

- To take an action when the number of temperature alarms 
reaches a certain value, next to Signal to check choose either 
Low temp errors or High temp errors and select the threshold of 
alarm errors.

6. Insert the condition box in the Trial Control rule. 

For more information, see the EthoVision XT Help and the EthoVision 
XT 18 - Trial and Hardware Control - Reference Manual.
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The temperature alarm in data analysis

In an Analysis Profile you can define a temperature alarm variable, for 
example to visualize alarm events in the Integrated Visualization. This 
way you can review your trials and see if something has changed in the 
behavior of the larvae during those alarm.

1. In an Analysis Profile, under Hardware, click the button next to 
Hardware state.

2. Next to Device type choose DanioVision TCU (DVTCU-001x).

3. Next to Device choose the name given in the Arena - Hardware 
Mapping window (“TCU Temp alarm” in the example above).

4. Next to Signal:
- To visualize or calculate the duration of the time that the system 

was in temperature error state during the trial, select Low temp 
error state for a low-temperature alarm, or High temp error 
state for a high-temperature alarm. Next to Value select true. 
Select false if you want to visualize or calculate the time that 
there was no temperature alarm. 

- To visualize or calculate the duration of the time when the 
system had more (or less) a certain number of temperature error 
alarms, choose Low temp errors or High temp errors. Choose 
whether the number of errors was higher/lower or equal to a 
threshold value. Keep the option Cumulative selected.

5. In the Trial Statistics tab, select the statistic you want and click OK.

6. optional  Right-click the row Hardware state and select Rename. 
Enter a custom name (for example “Hardware state Low Temp 
alarm”).

The figure below shows part of the Integrated Visualization windows 
of a trial in which first a low-temperature alarm occurred, and after 
that a high-temperature alarm.
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The temperature alarm in the hardware log

Do the following to export the hardware log containing the TCU alarm 
events.

1. Choose Analysis > Export > Raw Data.

2. In the Raw Data Export window, make sure to select the Hardware 
log check box.

3. Click Start export to export the data.

carry out an experiment

note  If you want to log temperature errors, configure EthoVision XT 
beforehand. See optional: temperature alarm on page 89.

Procedure

1. Follow the procedure Normal use with set water temperature on 
page 85.

2. Wait that the temperature has reached the set value and no error 
codes appear on the LCD screen of the TCU.

3. Insert a well plate with the larvae into the basin. To prevent air 
getting trapped underneath the well-plate, put the back of the well 
plate against the wall with the shape of “” and place it on the basin 
floor, then tilt the front of the well plate down to the basin floor.

As you do this, water flows into the over-flow part of the basin.
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4. Lower the Fresnel lens over the well plate and close the DanioVision 
Observation Chamber. You can now carry out an DanioVision 
experiment as usual.

5. If necessary, grab a background image and define the arenas (page 
page 50) and define the Detection Settings (page 66). See also the 
EthoVision XT Help.

6. Choose Acquisition > Open Acquisition. Start the trial.

7. At the end of the experiment, follow the procedure 2 - Drain the 
system on page 84.

important  Draining prevents contamination from building up 
inside the system. Before you drain the system, make sure the drain 
tube with blue connector ends in a sink or container.

View the temperature alarms during the trial

 On the Temperature Control Unit

If an error occurs in the Temperature Control Unit, an error message 
appears on the display. See feedback and error messages on page 
104 for an explanation.

 On the EthoVision XT screen

a Choose Show/Hide > Show Dependent Variable.

b From the Select hardware list, choose Hardware state. Click OK.

c Next to Device type choose DanioVision TCT (DVTCU-001x). 
Choose the signal you want to display. Click the Statistics tab and 
choose the statistics of that signal that you want to display.

tip  Choose Current to display whether a temperature alarm is 
occurring.

d During acquisition, in the Analysis Results and Scoring pane click 
the Dependent Variables tab. There you can view the alarm state 
(under the arena A1). Here, true means error state.
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refill the basin during long experiments

The Basin Refill Tool

During long-lasting DanioVision experiments, evaporation of water out 
of the basin could be an issue. You can compensate for evaporation by 
refilling the basin without opening the DanioVision Observation 
Chamber (DVOC-0040).

The Basin Refill Tool (DVBR-0010) allows you to refill the basin without 
opening the DanioVision Chamber during an experiment. It is provided 
standard with the DanioVision Temperature Control Unit (DVTCU).

important  It is possible to fill/refill the basin directly (see Chapters 3 
and 4 in this Manual). However this is not practical when an 
experiment is running. 

Only use the Basin Refill tool in combination with the DanioVision 
Temperature Control Unit (DVTCU).

Set up the Basin Refill Tool

You must install the Basin Refill Tool before starting the experiment.

1. Make sure your DanioVision basin is empty. To do so, follow the 
instructions in the Section 2 - Drain the system on page 84.

2. Disconnect the tube marked in green between the DanioVision 
Chamber and the TCU (when applicable). 
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3. Connect the ends of the tubes of the Basin Refill Tool to the 
corresponding green-marked inlets at the back of the DanioVision 
Observation Chamber and the Temperature Control Unit:

4. Make sure the faucet is closed (Off position).

5. Fill the syringe with basin liquid, and connect it to the short faucet 
tube.

6. Fill the basin circuit (see page 85).

tip  While the basin circuit is being filled, insert a few ml liquid out 
of the syringe in order to prevent air bubbles from getting into the 
circuit. 

7. Start the experiment as usual.

Use the Basin Refill

How much liquid to insert via the syringe depends on the level of 
evaporation and the duration of the experiment. Add liquid into the 
basin circuit whenever needed.

During refill, do not switch off the Temperature Control Unit!

1. Open the faucet (On position).

2. Make sure you can see the overflow outlet of the DanioVision 
Chamber (red marked tube).

3. Gently push the syringe to insert liquid. 
98  10 - The DanioVision Temperature Control Unit



4. Carefully watch the overflow tube. Whenever the liquid comes, stop 
pushing the syringe.

notes

 Overflow is a good indication for a 100% filled basin, however it 
may lag on filling.

 The DVTCU will, whenever occur, compensate any temperature 
fluctuation due the refill. However, make sure that the liquid 
temperature in the syringe is not too far from the desired basin 
temperature.

To refill the syringe

1. Make sure the faucet is closed (Off position).

2. Disconnect the syringe. 

3. Fill the syringe with basin liquid.

4. Make sure no air is present in the syringe.

5. Connect the syringe back to the faucet tube.

maintenance and support

Replace the filter

The filter inside the DanioVision Temperature Control Unit is a particle 
filter with a pore size of 20 μm. The filter does not remove bacteria 
and/or yeast.

tip  The filter can get blocked after you have used the system for a 
longer period of time. When this happens, you will get an ‘insufficient-
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flow’ error message. Please first check the error table (page 104). 
Contact Noldus IT to order a new filter.

important  Before replacing the filter, drain the system (see page 84 for 
how to do this).

Make sure to use demineralized or distilled water to prevent small 
particles (> 20 μm) from blocking the filter.

1. Open the lid of Temperature Control Unit by unscrewing the white, 
plastic screw at the front of the unit. You can use a small 
screwdriver or a coin to do this.

2. Remove the left side panel by unscrewing the two screws at the top 
and three screws at the bottom of the side panel (indicated in the 
figure below).
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3. Lift the filter from the clamp and disconnect the tubes at both ends 
from the filter.

4. Insert the new filter, connect the tubes and push the filter back into 
the clamp. Make sure the small black arrow on the filter points in 
the direction as shown in the figure above.

5. Put the side panel back in place and close the lid of the Temperature 
Control Unit.

Replace the liquid coolant

1. Open the lid of Temperature Control Unit by loosening the plastic 
screw at the front of the unit.

2. Remove the left side panel by unscrewing the screws at the top of 
the side panel (see the figure in step 2 on page 100).

3. Locate the cap on top of the reservoir for the liquid coolant. This 
differs slightly between TCU versions (see the figures below).
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4. Unscrew the cap using for example a small coin.

5. Use the funnel to fill the reservoir with the liquid coolant.

We recommend to fill it to maximum level.

After refilling the liquid coolant, turn the Operation switch to Fill/
Drain to make sure the tubes inside the Temperature Control Unit 
are also filled with liquid coolant. As a result, the level of coolant in 
the reservoir might drop a bit. Add more coolant so it reaches the 
Max level.

6. Screw the cap back on the reservoir.

7. Put the side panel back in place and close the lid of the Temperature 
Control Unit.

Make sure to regularly check that the level of coolant does not drop 
below the Min indication on the front of the Temperature Control 
Unit. If the level is too low, refill the coolant.
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Contact Noldus IT if you want to purchase a new bottle of liquid 
coolant.

Wear and tear

All Noldus hardware is sold with a two-year guarantee. That means 
that if it breaks within two years of the delivery date, it will be repaired 
or replaced at Noldus' expense. Please see the document ‘Noldus 
guarantee’ to see what is covered by the guarantee.

Wear and tear caused by regular, normal use of the DanioVision 
Temperature Control Unit is not covered by the guarantee. Below are 
some recommendations about environmental conditions and cleaning 
of the Temperature Control Unit.

Environmental conditions

See the specifications on page 184, under Environmental conditions.

Cleaning the TCU

To clean the DanioVision Temperature Control Unit, use a damp cloth. 
Please do not use chemicals or soap to wash the Temperature Control 
Unit. Make sure that no liquid gets into the Temperature Control Unit.

For how to clean the DanioVision chamber, see page 183.

Keeping the tubing clean

It is very important that the tubes are kept as dry as possible when not 
using the DanioVision and the TCU. To prevent the growth of algae in 
the tubing, do the following:

 Always fill the system with demineralized water, and drain it after 
the end of an experiment.

 Keep all units and the tubes far from sunlight.

Technical support

If after reading this manual you still have questions, please contact our 
help desk at my.noldus.com.
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Event data logger

If you purchased a DanioVision Temperature Control Unit after 
November 2016, this is equipped with a board and a compact SD card 
that records performance data during functioning. If you encounter 
problems when using the Temperature Control Unit, the Noldus Help 
desk may ask you to send the files stored in the card. In that case, the 
Noldus help desk will send you the instructions for how to that.

feedback and error messages

The DanioVision Temperature Control Unit gives feedback about its 
status with four LED lights and error codes on the temperature display.

For the LED lights on the front panel: see below.

For the indicators on the temperature display: page 110

For the error codes displayed on the temperature display: page 111.

LED indicators
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Status LED Explanation What to do?

Filling / 
Draining

Orange - 
blinking

System is 
pumping.

The system can be filled with 
water  
(see step 5 on page 86).

Water can be drained from the 
basin  
(see page 84).

Cooling liquid can be filled (see 
page 101).

Filling / 
Draining

Red - 
continuous

Time out. There 
has been no 
flow in the 
water circulation 
and/or the 
cooling liquid 
circulation for > 
10 minutes.

Reset the system by turning the 
Operation switch to Off and 
then back to Fill/Drain.

Heating / 
Cooling

Green - 
blinking

The water is 
being heated/
cooled to the set 
temperature.

Wait. No action needed.

Ready Green - 
continuous 

The set 
temperature has 
been reached 
and the system 
is ready to be 
used.

The Temperature Control Unit is 
ready to be used and an 
experiment  
can be started.
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Error Red - 

1 blink - 
repeatedly

Insufficient flow 
in the water 
circulation.

Look for the source of the 
problem. This may be: 

 Low water level in the basin 
(due to evaporation or 
leakage). In this case, fill 
the system (step 5 on page 
86).

 Flow blockage somewhere 
in the system or filter 
clogged. See page 99 or 
contact Noldus to replace 
the filter.

 Pump failure.

The Fill/Drain mode can be used 
to localize the problem. Reset 
the system by setting the 
Operation switch to Off and 
then to Fill/Drain.

Status LED Explanation What to do?
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Error Red - 

2 blinks - 
repeatedly

Insufficient flow 
in the cooling 
liquid 
circulation.

Look for the source of the 
problem. This may be: 

 Low cooling liquid level in 
the pump reservoir. Check 
if the liquid level is above 
the indication. If not, refill 
cooling liquid (see page 101 
for instructions) and check 
for signs of leakage in the 
emergency liquid container.

 Flow blockage somewhere 
in the system.

 Pump failure.

The Fill/Drain mode can be used 
to localize the problem. Reset 
the system by setting the 
Operation switch to Off and 
then to Fill/Drain.

Error Red -

3 blinks - 
repeatedly

The fan is not 
spinning, or not 
spinning at 
sufficient speed.

Check if there is anything 
blocking the fan. If this is not the 
case, please contact Noldus 
support. 

Status LED Explanation What to do?
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Error Red - 

4 blinks - 
repeatedly

System is 
overheated.

Turn off the system and end the 
experiment. Cooling liquid can 
be cooled down by switching the 
Operation switch to Fill/Drain. 
Search for the possible cause of 
the overheating:

 Air vents of the 
Temperature Control Unit 
might be blocked so the 
radiator cannot get rid of 
its heat. Make sure air 
vents are free.

 System is used in 
environmental conditions 
that have not been tested, 
for example, room 
temperature >35°C.

Error Red - 

5 blinks - 
repeatedly

Heating and 
cooling have 
been activated 
simultaneously. 
An electrical 
problem has 
occurred.

Please contact Noldus support.

Status LED Explanation What to do?
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Error Red -

6 blinks - 
repeatedly

A problem with 
the data logger 
has occurred.

Open the TCU and take the SD-
card out. 

 If it is locked, unlock it.

 Check that it has a 
minimum capacity of 4 GB.

Next, put the SD-card back in the 
TCU. If the error persists, take 
the card out, and format it 
(FAT32). Leave the card empty; do 
not copy the old files to the 
newly-formatted card. Next, put 
the SD-card back in the TCU and 
restart the TCU.

Error Red - 
continuous

A temperature 
deviation larger 
than 0,5°C above 
or below the set 
temperature has 
been detected. 

Water conditioning will continue 
to try to resolve the situation. 
Once the situation is resolved 
the status of the system returns 
to 'Ready'.

Depending on your protocol you 
can choose to continue or to 
abort the experiment.

Status LED Explanation What to do?
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Temperature display

0

Code Explanation

1 The water is being heated to the set temperature.

2 The water is being cooled to the set temperature.

3 The current water temperature is at least 0.5°C below the 
set temperature. It is shown together with the 
temperature alarm code E05. In normal conditions, when 
code 3 is shown, code 1 is also shown and the red Error LED 
(re-continuous) is on.

4 The current water temperature is at least 0.5°C above the 
set temperature. It is shown together with the 
temperature alarm code E04. In normal conditions, when 
code 4 is shown, also code 2 is shown and the red Error LED 
(re-continuous) is on.

Error mode (see page 111)

This is a system setting indicator, which blinks when the 
TCU is in heating/cooling mode. No action need be taken.
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Error codes

LCD is off A possible reason is that one of the flat cables coming from 
the LCD display is not properly connected. Open the DV-
TCU, locate the multi-color flat cable (3rd to the right of the 
CD card), disconnect it and connect it again. 

Error code Explanation What to do?

E01 The temperature 
sensor is not 
detected.

Please connect the temperature 
sensor cable (with cinch-plugs on 
both ends).

E04 ‘Too high’ 
temperature alarm. 
The measured 
temperature is 0,5 °C 
higher than the set 
temperature. See 
‘Red – continuous’ 
LED on the table 
beginning on page 
104.

Depending on your protocol you can 
chose to continue or abort the 
experiment. Please note that this 
error also occurs while the system is 
Heating/Cooling before the start of 
the experiment; the system 
continues to heat/cool to try to 
resolve the error.

Code Explanation
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E05 ‘Too low’ 
temperature alarm. 
The measured 
temperature is 0,5 °C 
lower than the set 
temperature. See 
Error with ‘Red – 
continuous’ LED on 
the table beginning 
on page 104.

Depending on your protocol you can 
chose to continue or abort the 
experiment. Please note that this 
error also occurs while the system is 
Heating/Cooling before the start of 
the experiment.

Ed1 System error. See Status = Error on the table 
beginning on page 104.

nO Another display has 
been selected 
accidentally.

1. Press the up or down arrow until 
the code b1 appears on the display.

2. Press the Set button for three 
seconds to confirm. 

Error code Explanation What to do?
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11 The DanioVision Tapping Device

introduction

Larval stage zebrafish display a robust startle response, which is 
mediated by neural pathways similar to that in higher vertebrates. 
With the DanioVision Tapping Device you can evoke a startle response 
in zebrafish larvae.

How the Tapping Device works

The DanioVision Tapping Device is based on an electromagnetically 
inductive coil wound around a metal core. The core is made of two 
parts, a fixed one and a plunger connected to a push pin. When a 
current flows in the Tapping Device, magnetic force is created between 
the plunger and the core, causing the plunger and the push pin to 
quickly move forward (as indicated by the blue arrow in the picture). 
The pushpin hits a metal plate attached to the basin in which the well 
plate is kept. When deactivated, a spring makes the plunger resume its 
position.
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Controlling the Tapping Device

With the Trial and Hardware Control module of EthoVision XT you can 
plan when to activate the Tapping Device during a trial. For example, 
activate the Tapping Device 10 times at intervals of two minutes. 

Noldus test results: a summary

 In both light and dark conditions, the Tapping Device is capable of 
inducing a startle response in animals of 3 dpf and older. 

 It is in principle possible to design experiments where the animals 
are subject to stimuli of different intensity. You can set the tap 
intensity in EthoVision XT (page 117). 

 There is no evidence that the startle response measured by 
EthoVision XT depends on light conditions and location of the 
subject in the well plate.

important  We advise you not to compare the results between two 
DanioVision Observation Chambers provided with the Tapping Device. 
Slight differences in the position of the Tapping Device may result in 
differences in the actual stimulus intensity, all else being equal!
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install the daniovision tapping device

If you order the Tapping Device together with a DanioVision 
Observation Chamber, the Tapping Device is already installed. In all 
other cases:

1. Open the lid of the DanioVision Observation chamber, and remove 
the bench plate (see also page 166).

2. Remove the two bolts from the aluminium plate at the bottom of 
the chamber as indicated in the figure below. Make sure that the 
backlight box does not move.

tip  Use a pencil to mark the exact position of the backlight box on 
the frame so that you can place it in that position if it accidentally 
moves.
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3. Put the metal frame of the Tapping Device over the aluminium 
profiles, and fix the bolts with the supplied spring washers. Use 
both the already connected spring washers and the new ones.

4. Connect cables as indicated here.

a The cable with a 4-pin white connector comes from the Tapping 
Device.

b The flat cable with a blue connector comes from the bottom of 
the DanioVision chamber. Raise the metal hooks, insert the 
connector, then lower the hooks to fix the connector.

c The cable with 2-pin connector comes from the bottom of the 
DanioVision chamber.
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5. Attach the control box to the aluminium profile at the front side of 
the observation chamber. 

a Insert the screw in one of the hole at the sides of the control box.

b Attach the spacers and the sliding nuts to the screw.

c Insert the sliding nuts into the profile, and turn the screw. 

6. Put the bench plate back into place and fix the four screws.

set up the tapping device in ethovision xt

Make sure that the DanioVision Observation Chamber is connected to 
your EthoVision XT computer.

Experiment Settings

Under Trial Control hardware, click Settings. In the Hardware Interface 
window, select DanioVision DVOC-004x/T.

Arena settings

note  If you created an experiment with a pre-defined template and 
selected an arena template for DanioVision with the Tapping device 
(DanioVision DVOC 004x/T), the Tapping Stimulus has been assigned 
automatically to the arenas. The steps below are then not necessary. 
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1. In the Arena Settings pane click Arena - Hardware Mapping and 
then click the Arena - Hardware Mapping button. 

2. Click Add device. Under Device type, select Tapping Stimulus. Under 
Arena 1 select Tapping Stimulus.

3. To test the Tapping Device, select the cell under Arena 1 and click 
Test.

Trial and Hardware Control Settings

1. Open the Trial Control Settings containing the protocol in which 
you want to insert the Tapping Stimulus. Under Actions - Hardware 
click the button next to Tapping Stimulus.

2. In the Hardware Action window specify the Intensity level (1-8). Click 
Test to get an impression of the tap intensity.

3. Click OK and insert the Action box in your Trial Control protocol. 

4. Test the protocol before carrying out the real trials.

important  Allow at least 300 milliseconds between two consecutive 
tapping events. To do so, place a Time condition box that specifies this 
time between two Tapping Stimulus Action boxes.

note  If the Tapping Device does not respond to the test action, for 
example after it has not been in use for long time, open the bench plate 
(page 166) and use a screwdriver to gently push the pushpin back, then 
release and have it hit the metal plate as if it was activated. Do this a 
few times and then test the action again. Also check the connections 
inside.
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analyze the response to the tapping stimulus

You can analyze the startle response by looking at dependent variables 
like Activity, Distance moved, or Acceleration (state) immediately before 
and after the administration of the stimulus.

In the following example, we examine the Total Distance moved in the 
1-second periods immediately before and after the tapping stimulus 
command was given. We expect that the total distance moved 
increased from “before” (assumed to be a baseline) to “after”. The 
stimulus command was given at exactly 1 minute after the start of the 
trial. 

1. In the Data profile define two Nesting time intervals, one from 
00:59.00 to 01:00.00, the other from 01:00.00 to 1:01.00. Each of 
the resulting Nest box is connected to a separate Results box.

2. In the Analysis profile define Distance moved.

The following picture shows the Distance moved plotted in Integrated 
Visualization.

Figure 17  An example of per-sample distance moved plotted against time for two 
subjects, and in the 1-s period before (59 s – 60 s) and after triggering the Tapping 
Device (60 s – 61 s). The hairline indicates the time that the stimulus was 
administered. 
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12 The DanioVision Toplight Unit

This manual explains the setup and operation of the DanioVision 
Toplight (type DVTL-0020) for the DanioVision Observation Chamber 
DVOC-0041.

note  The DanioVision Toplight Unit is an add-on to DanioVision; it 
does not come with a standard DanioVision system. For the 
specifications, see daniovision toplight unit on page 186.

connect the toplight unit

Components

 DanioVision Observation Chamber with built-in Toplight Unit.

 Desktop power supply, TTL-to-28V interface and cabling (see the 
figure below).

Operation

With this setup, two of the LED colors, or the white light can be 
switched on and off from EthoVision XT. The TTL-to-28V interfaces 
enable switching the power from the desktop power supply.

note  Whenever you would like to use all three colors (R-G-B) within 
one experiment you’ll need a second TTL-to-28V interface.

important  The LEDs get hot during operation. Please let the ceiling 
light cool down before touching it

important  Do not exceed the maximum specified voltage for each 
color as doing so may damage the LEDs

Setup for the white light

1. Desktop adjustable supply set to max 18 V for white light.

2. TTL cable to free TTL port on the DanioVision Observation 
Chamber’s (DVOC) back panel.
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3. White light cable plugged in.

4. Top light cable from the DVOC’s back panel.

5. Main LED power cable.

Connect the components

The LED power cable (coming from the back of the DVOC) has 4 
connectors, one for each LED color. The connectors belonging to the 
appropriate colors should be connected to the TTL-to-28V interface on 
outputs 1 and 2. 

The TTL network cable (green) should be connected between the TTL-
to-28V interface and port 1 on the DVOC (see the next figure). 

A main power cable connects the desktop power supply to the input of 
the TTL-28V interface. 
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1. USB cable to EthoVision XT computer.

2. TTL cable running to TTL-to-28V interface.

3. LED power cable.

operate the power supply

On the power supply the voltage can be set which determines the 
amount of light that the LEDs emit. The voltage may not exceed the 
maximum voltage for each LED color. This is 24V for the Red, Green and 
Blue LEDs and 18V for the white LEDs. 

important  Higher voltages may damage the LEDs. Before connecting 
to the mains outlet, check that the mains voltage matches the voltage 
setting of the power supply.

To power up, press the power button.
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To adjust the voltage

Turn the Voltage knobs for coarse and fine adjustments. Or when in 
presence of one knob, press once for coarse adjustments, and press 
once more for fine adjustment. The actual output voltage can be read 
from the display.

Both “Current” knobs can be used to set a current limiting value 
(maximum current). This feature is not needed; just set to the 
maximum level (turn full clockwise).

If not set properly, the supply may come in Constant Current mode (CC) 
and limit the output voltage.

It is good practice to first set your desired voltage before actually 
connect the main LED power cable to the supply.

For more information, see the supply manual.

change the lights

Two switch between red, green and blue

To change between colors, simply unplug the current connector of the 
LED power cable from the TTL-to-28V interface and plug in the correct 
one. Each connector is labeled.
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To switch between white and colors

If you want to switch from RGB to white light (or vice versa), turn the 
complete unit in order to have the right LEDs facing down towards the 
well plate.

The RGB LEDs and white LEDs are mounted on the opposite sides of the 
same plate and can be identified by the label white and rgb attached.

1. Cover the lens bracket with some protective material.

2. Untighten both left and right round black knobs to enable the unit 
sliding down a few centimeter, just below the camera. 

3. Pull the unit out and turn it upside down (facing the preferred LED’s 
down).

important  Be careful not to twist the cable at the back. Unplug 
temporarily both connectors to prevent this from happening.

4. Insert the unit and slide it up again.
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5. Tighten both round knobs.

solution with four leds connected 
simultaneously

You can use two TTL-to-28V Interface boxes to have the three RGB leds 
and the white led connected simultaneously and ready for use. This is 
handy if for example you want to activate the green and the red LEDs 
within the same trial. 

Make the connections as shown here.
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 It does not matter which of the two connectors under 28V supply 
in/out you use to connect the power supply. Either connector is fine 
since the two are made for power feed-through.

 The system is designed to use either the white light or the colors. 
See To switch between white and colors on page 124. However, this 
solution allows to have the LEDS already connected so you can 
switch between green, red and blue using the Trial Control actions.

 Connect the two TTL-to-28V Interface boxes to two TTL ports at the 
back of the DanioVision chamber, TTL 1 and TTL 2, or other ports if 
the former are already connected (e.g. to the Temperature Control 
Unit).

 Each TTL cable conveys two output lines from EthoVision XT 
(Output 1 and Output 2). So with one TTL port you can control two 
colors, depending on what connector on the TTL-to-28V Interface 
box a LED is connected to: e.g. Red for Output 1 and Blue for Output 
2. You can specify the Output number in the Trial Control actions 
(see the next two sections). 

important  Remember that the white light needs 18V voltage, not 
higher! Make sure that the voltage set matches the LEDs you use.

configure ethovision xt to control the top 
lights

1. Start EthoVision XT and create a new experiment using a template 
(File > New from template). 

During the guided setup, choose Live Tracking, Zebrafish larvae, 
DanioVision [with the type of well plate you use].

2. Choose Setup > Experiment Settings. 

Under Trial Control Hardware, select Use of Trial Control Hardware 
and choose the options as in the figure below. Choose the TTL port 
of the DVOC that you connected (see above). You can rename 
Device ID to something like “Ceiling Light”.
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3. Choose Setup > Arena Settings. 

After calibrating and drawing the arenas, click Arena Hardware 
Mapping. Click Add device and follow the picture below. You can 
rename the text under Device name to something like “Ceiling 
Light”. Under A1 select the device. Then Click OK.
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4. To test the light, select Output 1 High or Output 2 High from the 
Command menu and click the Test button. To turn them off, select 
Output 1 Low or Output 2 Low.

program the top lights in ethovision xt

Choose Setup > Trial Control Settings.

Example: After 1 minute during the trial, switch the light on, then after 
10 seconds switch it off.

 Under Conditions, choose Time to create a time condition (e.g. Wait 
1 minute, Wait 10 seconds).

 Under Actions, choose Custom Hardware to define commands 
(Switch on/off). This can be done for both output 1 and output 2. 

Remember to connect all boxes with the start-stop procedure.
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Create routines

With the Subrule function you can create routines, to switch on and off 
the lights in repeated sequences. 

For more information, see the EthoVision XT 18 - Trial and Hardware 
Control - Reference Manual.

Also adjust the Detection Settings (Setup > Detection Settings) before 
running the trials.
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13 The DanioVision Optogenetics 
add-on

introduction

Optogenetics allow scientists to control the activity of specific neurons 
and study their downstream influence on a variety of biological 
processes, including behavior. In rodent studies, this technique requires 
optical fiber implantation. When working with zebrafish larvae, mostly 
transparent, fiber optics are not needed Light simply needs to shine in 
the right direction, making it easy to assess the effect of stimulation of 
specific, light-sensitive neurons on the behavior of the fish.

By inserting light-sensitive receptor proteins into neurons in vivo, it is 
possible to make those neurons sensitive to activation by light of 
specific wavelengths. In zebrafish studies, the light-sensitive receptor 
protein halorhodopsin (NpHR) has successfully been used to inhibit 
swimming behavior in zebrafish larvae (Arrenberg et al. 2009). Other 
research showed that channelrhodopsin-2 (ChR2) activation induced 
backward swimming in a sparse transgene expression line (Zhu et al. 
2009).

Optogenetics add-on

Application of optogenetic stimulation in zebrafish larvae requires the 
correct wavelength (i.e., color) of light. When using the DanioVision 
Observation Chamber, the Optogenetics Add-on provides a way to 
accurately control and precisely time the application of optogenetic 
stimulation to up to 96 individuals simultaneously (working with 96 
well plates).

The Optogenetics add-on for DanioVision is an optogenetic LED light 
source based on the Prizmatix Modular LED system. It consists of one, 
two or three LED wavelengths. The Optogenetics add-on can be 
programmed and controlled using the EthoVision XT software included 
with your DanioVision system. You can set user-defined time 
conditions for the optogenetic stimulation. In comparison to manual 
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control, this offers far better temporal precision and adds efficiency to 
longitudinal studies. 
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and the Tet system. Frontiers in Neural Circuits 3: 21.

Sample experiment

Your DanioVision system comes with an EthoVision XT sample 
experiment: DVOC_Optogenetics_Demo_Recommended.evxt. It 
contains examples of Trial Control rules for triggering pulse sequences 
in one up to three Pulsers.

Additional manuals

 For connecting the hardware: Prizmatix UHP-T LED Illuminator User 
Manual.pdf.

 For programming the Pulser: Prizmatix Pulser User Manual.pdf.

 For connecting the DanioVision Temperature Control Unit: This 
manual, page 76.

install the dichroic mirror in daniovision

When you receive the DanioVision Observation Chamber DVOC-004x 
with the Optogenetics add-on, the LEDs are already mounted so you 
only have to connect the cables (see the next section). However, the 
dichroic mirror comes in a separate box to prevent damage during 
shipping. This section explains how to install it. Please follow the 
instructions below. 
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note  The function of the dichroic mirror is to direct the color light 
beams to the well plate, and at the same time allow light to reach the 
camera, so you can film and track the fish during the test.

1. Locate the box containing the mirror.

Wear the supplied gloves to avoid damaging or dirtying the mirror. 
Avoid touching the mirror surface and only hold its edges.

2. Locate the arrow on one side of the mirror. Once the mirror is 
mounted, this arrow should be at the top of the mirror and point 
towards the light source, that is, the backside of the Daniovision 
chamber.

3. Attach the mirror (see the next picture). Slide the mirror upwards 
along the brackets as indicated by the arrows.
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4. Position the mirror just above the mark on the right-hand bracket 
(see the picture below, 1). When the mirror is in that position, 
carefully tighten the screw on the left to fix the mirror (2). Do not 
apply any force as this may damage the mirror.

5. The mirror is now ready to use. See the next sections.

important  The LED is extremely powerful and may cause eye injury 
when looking directly into the light source. For testing, we recommend 
to set the LED intensity to low.

the pulser software

Please skip this section if you do not use the Pulser/PulserPlus devices.

Follow the procedure below if you use one or more Pulser/PulserPlus 
devices. To control multiple devices, multiple instances of the Pulser 
software must be running on the EthoVision XT computer.

important  Do not connect the Pulser/PulserPlus device to the 
computer until the software setup process is complete.

Install the Pulser software once

1. Copy the installation files and folders to your computer’s hard 
drive.
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2. Run the setup.exe file and follow the instructions as they appear on 
the screen. Next, restart the computer to complete the software 
installation.

3. Open the folder where the software has been installed (default: 
C:\Program Files (x86)\Prizmatix Pulser Plus 3.2.1) and make a 
shortcut to the EXE file. Give the shortcut a name that is easily 
recognized, like Pulser A or the name of the first LED.

4. To install or update the Pulser/PulserPlus drivers, see the Pulser/
PulserPlus User Manual.

Install multiple instances of the Pulser software

To control two or three LEDs independently using the dedicated Pulser/
PulserPlus devices, install one instance of the Pulser software for each 
Pulser/PulserPlus.

1. Install the first instance of the Pulser software (see above).

2. Browse to the folder C:\Program Files (x86) and copy the entire 
folder Prizmatix Pulser Plus 3.2.1.

3. Paste the folder in the same location C:\Program Files (x86). 
Rename the folder to Prizmatix Pulser Plus 3.2.1 PulserB.

4. Open the new folder and make a shortcut for the EXE file that you 
find there. Place the shortcut on your desktop. Name it like Pulser B 
or the name of the second LED.

5. If you have a third LED, repeat the steps above from 2 to 4 to create a 
new folder which will contain a third instance of the Pulser software. 
Make a shortcut to the new EXE file and rename it to e.g. Pulser C. 

6. You should at this point have a folder structure like the following:

and three shortcuts on your desktop.
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led controller uhptlcc

This device has a switch in the middle of the front panel.

Basic connections

1. Make sure the power switch (1) is set to Off.

2. Connect the 12VDC connector (10) to the power outlet through its 
power cable and adapter.
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3. Connect the LED cables (LED Control cable and LED Current cable) 
that come from the DanioVision system to the two LED connectors 
(8 and 9, respectively).

To control the LED manually:

1. Set the switch near TTL (5) to Int.

2. Set the switch near Ain (6) to Int.

3. Turn on the main power (see 1 in the figure above).

4. To turn the LED on, flip the switch (2) on.

To control the LED from EthoVision XT through TTL

1. Set the switch near TTL (5) to Ext.

2. Set the switch near Ain (6) to Int.

3. Turn on the main power (see 1 in the figure above).

4. To turn the LED on, flip the switch (2) on.

5. Connect the TTL cable with BNC connector from the pulser (or the 
back of the DanioVision chamber, depending on the setup) to the 
TTL connector on the back panel of the LED controller (4).

6. In EthoVision XT you can now give the “high” command using the 
Trial Control actions. See page 147 or 148 depending on the setup.

Other controls

 Power adjustment dial (3).

 Analog input (Ain) connector (7).
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led controller uhptlcc-02

This device does not have a switch in the middle of the front panel.

Basic connections

1. Make sure the power switch (9) is set to Off (O).

2. Connect the 12VDC connector to the power outlet through the 
power cable and adapter. 
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3. Connect the LED cables (LED Current cable and LED Control cable) 
that come from the DanioVision system to the two LED connectors 
(7 and 8, respectively).

To control the LED manually:

4. Set the switch near TTL (4) to Int.

5. Set the switch near Ain (5) to Int.

6. Turn on the main power  (9).

7. To turn the LED on and off, press the button (1).

To control the LED from EthoVision XT through TTL

1. Set the switch near TTL (4) to Ext.

2. Set the switch near Ain (5) to Int.

3. Turn on the main power (9).

4. Connect the TTL cable with BNC connector from the pulser (or the 
TTL 2/3 ports of the DanioVision chamber, depending on the setup) 
to the TTL connector on the back panel of the LED controller (3). 
Depending on the TTL lines you use you must choose between white 
connector (line 1) and red connector (line 2).

5. In EthoVision XT you can now give the “high” command using the 
Trial Control actions. See page 147 or 148 depending on the setup.
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Other controls

 Power adjustment dial (2), Analog input (Ain) connector (6).
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configuration 1 - without the pulser

Connection diagram

In the following example, EthoVision XT controls three LED controllers 
through the TTL ports in the DanioVision Observation Chamber. 
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Input lines

 Each TTL port can convey two lines. TTL port 2 is connected to two 
LED controllers through the two lines, Line 1 (white connector) and 
Line 2 (red connector). TTL port 3 is connected to the third LED 
controller through Line 1.

 Each TTL line controls one LED controller. You can specify TTL port 
and TTL lines in EthoVision XT.

Define the pulse sequence

To define a pulse sequence, use actions and conditions in the 
EthoVision XT’s Trial Control Settings. For example a 1-s pulse of light in 
the first LED can be defined as: Action Light On on port 1 > Time 
Condition (1 second) > Action Light Off on port 1. See trial control (no 
pulser) on page 147.

For information about creating pulse sequences in EthoVision XT, see 
the Chapter Optogenetics experiments in the EthoVision XT 18 - 
Application Manual. To open this manual, from the Windows Start 
menu choose All Apps > Noldus > EthoVision XT 18 Other 
Documentation.

USB ports

You need one USB port on the EthoVision XT computer, to control 
DanioVision.

TTL ports

 When using one LED, you can use the TTL-port 2 of DanioVision. Use 
the white connector at the other end of the cable to connect the 
LED controller.

 When using two or three LEDs, you can control two LEDs with one 
TTL port. Use TTL-port 2 for LED 1 and 2, and TTL-port 3 for LED 3. 
Remember that the white connector at the other end of the cable 
means Line 1 and the red connector means Line 2 in EthoVision XT.
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configuration 2 - with pulsers

Connection diagram
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USB ports

On the EthoVision XT computer, you need:

 One USB port, to connect DanioVision (see page 18)

 Additional USB ports, one for each Pulser (see page 143). Connect 
the USB port of each Pulser to a USB port of your computer.

TTL ports

 When using one Pulser, you can use the TTL-port 2 of DanioVision. 
Use the white connector at the other end of the cable to connect 
the Pulser.

 When using two or three Pulsers, you can control two Pulsers with 
one TTL port. Use the DanioVision TTL-port 2 for Pulser A and B, and 
TTL-port 3 for Pulser C. Connect the other end of the cable to the 
Trigger In port of each Pulser. Remember that the white connector 
at the other end of the cable means Line 1, and the red connector 
means Line 2.

experiment settings

Choose Setup > Experiment Settings > Click Settings next to Use of Trial 
Control hardware. Then follow the section below that applies to 
choose the port numbers in the Device Configuration window.

tip  Open the sample experiment DVOC_Optogenetics_Demo_ 
Recommended.evxt. This is a live tracking experiment where basic 
settings in Experiment Settings and Trial Control are already selected 
for when you work with three pulsers.

Configuration 1 - without Pulser

Each LED controller is connected directly to one TTL port of 
DanioVision. If for example you have three LEDs, choose Port 2 for the 
first two LEDs, and Port 3 for the third one. See the corresponding 
scheme on page 140.
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Configuration 2 - with Pulser

Each Pulser is connected to one TTL port of DanioVision. If for example 
you have three Pulsers, choose Port 2 for the first two Pulsers, and Port 
3 for the third one. See the corresponding scheme on page 143. Under 
Device ID, give each port a name that can be easily recognized.

arena - hardware mapping

Choose Setup > Arena Settings. Draw the arenas (see this manual). 
When the arenas are ready, click the Arena - Hardware Mapping button 
and make sure that the devices are selected under Arena 1 (A1).
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The figure below refers to a configuration with three Pulsers.

Test the triggering action

If you have connected the Pulser to DanioVision as shown on page 143, 
you can now test the trigger function of DanioVision.

1. important  Make sure that in the Pulser software the correct COM 
port is selected and that the operating mode is set to (3) Execute 
sequence after trigger HIGH, then stop when LOW.

2. Next, click the button Start sequence. Now the Pulser is listening to 
the trigger signal.

3. Click the row for a pulser (Pulser A and B, or Pulser C).

4. Click the Test button.
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5. In the window that appears, select Output 1 High or Output 2 High, 
depending on which Pulser you want to test: that of line 1 (white 
connector on Trig.In) or that of line 2 (red connector on Trig.In).

6. At this point the LED connected to that Pulser should be activated 
following the sequence defined in the Pulser software. If it does not, 
check carefully the cabling.

7. Next, see trial control (with pulsers) on page 148.

trial control (no pulser)

important  Before you follow this section, make sure that (1) the 
dichroic mirror is installed in the DanioVision chamber (page 131), and 
(2) all components are connected (page 140) and powered up, and (3) 
that the LED controller is set to TTL control (page 135).

When the LED is controlled directly from EthoVision XT, activation 
occurs in Trial Control, using the Action boxes. The duration of the light 
pulse is determined by a Time condition placed between the Action 
Output 1 High and Output 1 Low.

In the example below, LED 1 (Device D in the Arena - Hardware mapping 
window; see above) is activated with a TTL signal Output 1 High and 
after 0.5 it is deactivated with a TTL signal Output 1 Low. The LED 
Controller must be connected to DanioVision through TTL Port 1 - Line 1 
(see page 140).

Use Output 2 High/Low commands to control the other LED controller 
connected to the same DanioVision TTL port.

Make sure that the Int-Ext switch near TTL on the LED controller is set 
to Ext!
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trial control (with pulsers)

important  Before you follow this section, make sure that (1) the 
dichroic mirror is installed in the DanioVision chamber (page 131), (2) all 
components are connected (page 143) and powered up, and (3) that the 
LED controller is set to TTL control (page 135).

Procedure

1. Open all the instances of the Pulser software by clicking on the 
desktop shortcuts Pulser A, Pulser B, and Pulser C. Each instance 
controls one pulser.

2. For each instance of the software, next to Select COM port, choose 
the correct COM port for the corresponding Pulser. These can be 
found on the pulser or on the connection diagram.

3. Next to Select Operation Mode, choose one of the following:
- When testing the Pulser, choose (0) Execute pulse sequence 

after START. By pressing the Start Sequence button, the LED 
flashes the configured sequence. 

- When running the actual trials, choose (3) Execute pulse 
sequence after trigger HIGH, then stop when LOW. If you now 
click the Start Sequence button, the Pulser waits for a TTL trigger 
to start the sequence.

4. Enter the other settings in the dialog to control the pulse duration 
and the time between pulses. For details, see the Prizmatix Pulser/
PulserPlus User Manual.

5. Start EthoVision and open the example experiment: 
DVOC_Optogenetics_demo_recommended.evxt
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In the Trial Control Settings you find predefined routines (called 
subrules) to control three Pulsers. The main procedure (top row) has 
been configured to consecutively trigger the three Pulsers using the 
corresponding subrules. Make sure the pulsers all have the correct 
COM port, are all in mode 3 and the start sequence button has been 
pressed. See also configure the com port for each pulser on page 
151.

Here below you find the basic actions to control the triggering of 
the Pulsers. For more information, see also the Chapter 
Optogenetics experiments in the EthoVision XT 18 - Application 
Manual.

Basic subrule

A basic set of instructions in a subrule activates the Pulser a number of 
times, as specified in the Subrule Reference box.

The boxes within the subrule specify an action to trigger the pulse 
sequence (Send a signal High to a device through line 1 or 2), a Time 
(wait a number of seconds) and a second action which stops the pulse 
sequence (Send signal Low to a device through line 1 or 2).

In the following example, the subrule triggers the sequence in the 
Pulser A through Output Line 1, for 5 seconds. The name of the device 
selected next to Custom Hardware is 570 +520 nm, because it control 
two Pulsers, one for a LED of 570 nm (through Output Line 1) and one 
for a LED of 520 nm (through Output Line 2). You find the name 570 
+520 nm in the Arena - Hardware Mapping window of the Arena 
Settings in the demo experiment.

In practice, the subrule would look like the following:
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Make sure that the Int-Ext switch near TTL on the LED controller is set 
to Ext!

acquire the data

To acquire the data, choose Acquisition > Open Acquisition.

Important things to check

 Make sure that the green light of the button on the LED controller is 
switched on.

 Make sure that the Pulser software is open on your screen; there 
must be one instance of Pulser software for each Pulser.
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 Check that each instance of the Pulser software indicates that a 
COM port is selected (COM3, COM4, etc.) and shows the message 
Prizmatix Pulser is connected. 

 If you use the Pulser in trigger mode, in the Pulser software check 
that the Operating Mode is set to (3) Execute sequence after trigger 
HIGH, then stop when LOW. Next, click the button Start sequence. 
Now the Pulser is listening to the trigger signal.

Start the trial

To start the trial, click the Start Trial button. The optogenetics setup 
will be activated according to the Trial Control protocol that is active at 
that time. For more information, see Acquire data on page 72.

configure the com port for each pulser

Aim

To configure the COM port in such a way the Pulser/PulserPlus accepts 
commands from EthoVision XT.

Procedure

1. Connect the Pulser/PulserPlus to the PC using the USB cable with 
type-A to type-B connectors.

2. In the Control Panel, open the Device Manager.

3. Under Ports (COM & LPT), right-click USB Serial Port and select 
Properties.
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4. Click the Port Settings tab.

5. Make sure that the parameters are as below, then click OK.

6. Take note of the port number (in the example above it is COM3).

7. Repeat the procedure for each Pulser/PulserPlus.

Notes

 The COM port number is retained in the Pulser, so if you disconnect 
the Pulsers and reconnect them, you do not have to assign the COM 
ports again.

 tip  To know which COM port is assigned to which Pulser/PulserPlus 
device, disconnect the USB cable from one Pulser/Pulser Plus. Then, 
re-connect it. The item that appears under Ports (COM & LPT) 
indicates the COM port.

 tip  To change the COM port for a specific Pulser, in the Control 
Panel, open the Device Manager. Under Ports (COM & LPT), right-
click the COM port, select Properties, Port Settings, then Advanced. 
From the COM Port Number list select the COM port among those 
available.
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14 Data preparation

smooth the tracks

Track Smoothing profiles in the template experiment

 No Smoothing. Smoothing filters are not activated.

 MDM 0.2 mm - With this Minimal Distance Moved filter, you can 
reduce the effect of ‘jitter’ on the Distance moved variable. 
Applying this filter is recommended, however, it results in longer 
calculation times in the analysis.

Change these settings for your setup, if necessary.

More options

Use the Maximum Distance Moved filter to remove outliers in the 
track, due to erratic detection of objects within the arena. when the 
margin of the well is sometimes detected as the fish.

For more information on smoothing data, see Smooth the Tracks in the 
EthoVision XT Help.

select data

Data profiles in the template experiment

 All Data. With this Data profile you analyze all tracks separately.
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 Treated vs. Control - The data are split for analysis based on the two 
values of the user-defined variable Treatment: Treated and Control.

Analyze dark vs. light periods

In this example, the researcher wants to analyze the data in different 
light and dark periods, determined by the activation of the white light. 
In the Data profile, the function Trial Control State under Nesting is 
used to create intervals corresponding to the state of the white light. 

1. Choose Analysis > Data Profile > New. Give the new Data profile a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Trial Control State.

3. Select the period you are interested in, using the Trial Control 
actions. For example From Light On To Light Off (depending on what 
name the Light On/Off actions have in the Trial Control Settings).

4. Insert the Nest box in the Data profile sequence.

5. If you want to analyze different periods and have the results in the 
same table, create more Results boxes as shown in the picture 
below. To add a Result box, in the Components pane click the button 
next to Result. In each sequence, add a Nest box that specifies a 
different Trial Control State.
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6. Choose the dependent variables and run analysis (see page 160).

tip  See also the sample experiment DanioVision with 96 wells XT 
which you can download from our web site (see page 10). There you can 
find the Data profile mentioned here.

Analyze data excluding periods of inactivity

In this example we want to exclude the interval in which a larva was 
not moving.

1. Choose Analysis > Data Profile > New. Give the new Data profile a a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Movement.

3. In the Movement tab, you can set the following:
- Averaging interval (range 1 - 1000) – This is the number of 

samples across which changes in speed are calculated to 
determine whether the subject is moving or not. In order to 
reduce the sensitivity of the Movement variable to brief changes 
in velocity, the velocity data can be smoothed by taking the 
running average of the last n samples. Enter the averaging 
interval n or leave 1 if you do not want to smooth the velocity 
data.

- Start velocity – The velocity above which the subject is 
considered to be moving.
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- Stop velocity – The velocity below which displacements of the 
subject’s body points are no longer attributed to locomotion but 
to system noise, body wobble or pivoting on the spot.

4. Under Calculate nesting for, select Not moving.

5. Click OK. Insert the Nest box in the appropriate position between 
the Start and the Result box.

6. Choose the dependent variables and run analysis (see page 160).

For more information on the Nesting functions, see Analyze Track 
Segments in the EthoVision XT Help.

Analyze the intervals around the onset of the white light

In this example, we want to analyze two intervals:

 From 5 seconds before the onset of the White light stimulus, to the 
onset of the stimulus.

 From the onset of the White light stimulus, to 5 seconds after the 
onset of the stimulus.

The aim is to compare activity, speed and other parameters between 
the two intervals.

1. Choose Analysis > Data Profile > New. Give the new Data profile a a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Free interval.

3. Do the following:

Under Start criterion, select Trial Control. Choose the options as in 
the picture below.
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Under Stop criterion, select Time. Next to Elapsed time leave 
0:00:00.000 after start event selected. 

note  The term start event refers to the White light selected under 
Interval start.

Click OK and insert the Nest box in the sequence.

4. To create the second interval, choose first Result under Common 
elements. Click the middle of the Start box and drag to the Result 2 
box; this will connect the two boxes.
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5. Repeat the steps 2-3 to create a new Nest box, this time for the 
interval “from White light to 5-s after that”. In the settings, choose 
the criteria for the second interval: from “Trial Control - 0 seconds 
before Action: Light on” to “Time - Elapsed time 5 seconds after start 
event”.

Click OK and insert the Nest box in the sequence.
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6. Choose the dependent variables and run analysis (see page 160).

tip  Click Settings in the Result boxes and rename them, to for example 
“5-s Before white light” and “5-s after white light”. Those names will be 
shown in your results.
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15 Analyze the data

analysis profiles and options

Analysis Profiles in the template experiment

 Distance, Time & Movement - Contains the dependent variables 
Distance moved, Velocity and Movement.

 Path Shape - Contains the dependent variables Heading, Turn angle, 
Angular velocity and Meander.

 Rotation - Contains two instances of the dependent variable 
Rotation, to count the number of clockwise and counterclockwise 
rotations.

For more information on these and other dependent variables, see 
Dependent Variables in Detail in the EthoVision XT Help. Also see the 
chapter Analysis of Trial Control data in the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.

Analyze intervals

Make sure you have defined a Data profile which specifies the intervals 
you are interested in (see page 153). Next, in the Analysis profile choose 
your variables (e.g. Distance moved). Then visualize the data (see an 
example in Figure 18) and run analysis (see page 164).

Activity analysis

You can also use the dependent variable Activity state. This variable is 
only available when you selected Activity analysis in the Experiment 
Settings (see page 47 and page 69). 

With Activity state you can calculate how long and how frequent your 
subject has been in different activity states. These states depend on the 
total pixel change within the arena between a sample and the previous 
sample. It is important that all defined arenas have exactly the same 
size. The number of states (two to four) and their thresholds are user-
defined.
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Analyze convulsions

To analyze convulsions, you can use several variables, such as Velocity, 
Movement, Activity and Mobility.

Method 1 - With Movement. In this example, seizures are frequently 
characterized by fast zig-zag movements that last up to two seconds. 
To discriminate between seizure and no seizure, we use Movement, a 
variable based on the current (smoothed) velocity of the fish.

Figure 18  Example of visualization of data after nesting over a Trial Control 
State. Here the samples of Arena 1 are displayed in full color when the white light 
was on. Only those samples are subject to analysis. The first plot is of the variable 
Trial Control State (defined as: From Light on to Light off; it illustrates the effect of 
nesting), and the second is of Distance moved defined in the Analysis profile.
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1. Create an instance of Movement that is active when the velocity 
exceeds a specific threshold value. To get an idea of what the 
threshold should be, plot the values of velocity with an averaging 
interval of 5. Play the video until a seizure occurs in one of the wells, 
and look at the values of velocity for that subject. In this example, 
velocity is higher than 15 mm/s in this example. Check this in other 
wells and in a few videos and try to find an optimal cut-off value.

2. Create a Free interval that has the following settings:
- Start Criterion: Dependent Variable; Select Variable: Movement. 

Set Movement with a Start velocity threshold around 1.5 cm/s 
and a Stop velocity threshold a bit lower (say 1.3 cm/s). Select 
Statistic: Current Duration of Moving and choose a value like >= 
0.5 s. This way you filter out short swim burst that are less likely 
to be seizures.

3. Stop Criterion: same as above, with the difference that you select 
Current Duration of Not Moving >= 0.5 s. The free interval ends 
when the fish has been Not Moving for half a second. 

4. The resulting free interval captures the period of time when the 
velocity of the subject is higher than the threshold value.
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tip  To exclude sudden changes in velocity in the middle of a seizure, 
use an Averaging interval when defining Movement.

5. Calculate the necessary statistics, like the average duration of the 
seizures, the number of occurrences, etc.

Method 2 - With Mobility. Create a Mobility variable in your Analysis 
profile. Start with setting a High Mobility Threshold to a high value like 
95%, and an averaging interval of 2. Similar to Movement, Mobility 
should only capture the periods of the time when the subject is very 
active because of the seizure, excluding normal swimming activity. 
Compare the scores of Highly Mobile with those of convulsions 
obtained manually. Adjust the mobility thresholds until they match.

heatmaps

To create a heatmap of the subjects’ position, choose Analysis > 
Results > Plot Heatmaps. Choose the Data profile from the list on the 
toolbar to create a heatmap based on the data selected. 

Figure 19  Example of visualization of heatmaps in the sample 
experiment DanioVision with camera zoomed into four wells.
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Notes

 There is one scale for all the wells in the well plate. You cannot 
create separate scales for each well, unless you select single wells in 
the Data profiles (one well for each Results box).

 For DanioVision experiments, the Group Means button is not 
available.

 For more information on heatmaps, open the EthoVision XT Help 
and browse to Visualize data > Plot heatmaps.

calculate the statistics

Procedure

1. Choose Analysis > Analysis Profile > New.

2. Add the dependent variables of your interest (see the section 
analysis profiles and options on page 160). For an overview, see 
Dependent Variables in Detail in the EthoVision XT Help.

3. In the Trial Statistics tab, choose the statistics you want to calculate 
per trial for that variable. If you created groups of tracks in the Data 
profile, select additional statistics in the Group Statistics tab. 

4. Repeat steps 2-3 to add more dependent variables.

5. Choose Analysis > Results > Statistics & Charts. Choose the Data 
Profile from the list on the tool bar and click the Calculate button.

6. The results appears on the screen. The Trial Statistics tab shows the 
statistics per trial. The Group Statistics & Charts tab shows the 
statistics and charts from the summarized results of all trials. See 
Calculate Statistics in the EthoVision XT Help for details.

7. optional  Click the Layout button and change the layout of the 
results table.

Batch calculations

It is also possible to carry out multiple analyses with different filters, 
data profiles and analysis profiles. To do so click the Batch button.
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Make your selection from the lists under Select the profile 
combinations to calculate and click Add. When done, click Calculate. To 
view a specific analysis result, select the options from the lists on the 
toolbar. For more information on batch statistics calculation, see Batch 
statistics calculation in the EthoVision XT Help.
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A Open the DanioVision casing

tools you need

A Phillips or (preferably) a Pozidrive 
screwdriver, size 2.

Do not use electric screwdrivers!

bench plate

Remove the bench plate, for example, to 
install the Tapping Device and other, 
custom hardware you want to place 
inside the DanioVision Observation 
Chamber.

Also when opening the top casing (page 
167) it is handy to first remove the bench 
plate.

1. Remove the four screws as indicated in the picture below.

2. Remove the bench plate.
166 A - Open the DanioVision casing



top casing

Remove the top casing, for example, when 
you need to replace the camera.

1. optional  Remove the bench plate first (page 166), this makes the 
following steps easier.

2. Remove the eight screws as indicated in the picture below. 

Note that the screws located more internally are shorter than the 
others. These are attached to the aluminium frame.
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3. Close the lid and lift the top casing.

4. When putting the top casing back in place, make sure that you insert 
the sides into the bottom casing as indicated in the picture below. 
Then, tighten all the screws.
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sides and back casing

Remove the sides and back casing to 
access the connector box, wirings and 
internal tubings. In most cases you do 
not need to do so.

1. Follow the instructions on page 167 to remove the top casing.

2. Put the DanioVision Observation Chamber just over at the edge of 
the table and remove the three screws from the bottom plate. 
Repeat this step for the other side.
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3. Remove the two screws at the back as indicated in the picture below.

4. You can now lift the casing.
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connector panel

To remove the connector panel at the back of the observation chamber, 
remove the four screws as indicated in the picture below.

adjusting lid friction

You can adjust the friction of the Observation chamber lid. 

If the lid falls down easily or opens with much friction, it can be 
adjusted by loosening or tightening the three screws per hinge. 
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B Fine camera adjustments

Each DanioVision system is thoroughly checked and set to its optimal 
configuration. However, transport and handling of the system may 
sometimes cause slight changes in the camera position relative to the 
well plate, resulting in a sub-optimal video image. This section helps 
you restore the original settings. To open the DanioVision casing, see 
page 166.

centering the well plate horizontally

If the well plate is not centered horizontally:

1. Loosen the washer located behind the camera bracket, under the 
camera profile. 
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2. Turn the camera in the direction required until the well plate is in 
the middle of the camera view.

3. Tighten the washer to fix the camera in the new position.

centering the well plate vertically

If the camera is rotated forward or backward in its vertical plane, the 
video image may look like this:

1. Loosen the two bolts at the sides of the camera profile.
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2. Rotate the camera bracket forward or backward until the well plate 
is centered vertically in the video image.

3. Tighten the bolts.
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if the well plate looks rotated

If the margin of the well parallel is not parallel to the margin of the 
video image:

1. Open the DanioVision Observation Chamber and locate one of the 
bolts at the side of the camera profile (either left or right):

2. Loose the bolt using a 3-mm Allen key.

3. Gently move the camera bracket forward or backward until the well 
plate is in the correct orientation. When ready, tighten the bolt.
B - Fine camera adjustments 175



example of a good video image

Check that the well plate fills the video image as much as possible, 
with the letters A-H and numbers 1-8 well visible. 

Set the camera lens to maximum aperture. The image is overexposed 
when no water is present. 

Below an example of a good video image when water is present:

Tighten the three screws on the camera lens once the image is 
optimized.
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C Additional hardware

DanioVision offers additional connectors to attach and control custom 
hardware. These are Expansion 1 and Expansion 2 located on the back 
panel.

expansion 1

Expansion 1 is a female 25-pin DB connector. It provides four additional 
TTL out lines to control external hardware and input/output lines to 
trigger the DanioVision camera (for example at a specific event). 
Numbers in black indicate pins currently available. 

Pin number Description

1 TTL-out port 1

2 TTL-out port 2

3 TTL-out port 3
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TTL-out ports are open collector outputs with a common emitter on pin 
9 and 10. Voltage range 0 to 5 V.

Specify the custom hardware in the corresponding row of the Device 
Configuration window. For details, see experiment settings.

For more technical details and how to use these connections, contact 
Noldus Information Technology.

4 TTL-out port 4

5 - 8 Not available

9 Common emitter for TTL-out ports

10 Common emitter for TTL-out ports

11 I/O output camera

12-21 Not available

22 GND I/O camera

23 I/O input camera

24-25 Not available
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expansion 2

Expansion 2 is a 8-pin modular RJ45 feed through 
connector. 

You can use it to connect internal add-on hardware and get external 
signals in the DanioVision Observation Chamber.
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D System specifications

daniovision dvoc-0041

Dimensions

 61 x 32 x 46 cm (24 1/64” x 12 19/32” x 18 7/64”) (h x w x d) in closed 
position

 Door opening 36 x 29 cm (14 11/64” x 11 27/64”) (h x w)

Weight

 15 kg excluding power supply, external tubes and cables

Power supply

 Power requirements: 24 Volt DC, 2.0Amp (max)

 Mains adapter: input 100-240 Volt AC, output 24 Volt DC, 3.0Amp

Camera

 Brand, type: Basler acA1300-60gm

 Interface: Gigabit Ethernet (RJ45 connector, CAT5e or higher)

 Sensor: 1/1.8” Progressive Scan CMOS, monochrome

 Max. resolution: 1280 x 1024

 Max. frame rate: 60 fps

Lens

 12 mm Megapixel, C-mount, F1.4, includes IR pass filter

 Optional lens: 8 mm Megapixel, C-mount, F1.4, includes IR pass 
filter

Video performance (H x V pixels)

 Default: 1280 x 960 at 30 fps (in combination with 12 mm lens)
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 Optional: 

- 640 x 480 at 60 fps (in combination with 12 mm lens)

- 800 x 600 at 60 fps (in combination with 8 mm lens)

Maximum frame rates as measured in a 96 well plate setup.

Backlight unit

 Combined infrared (IR) and white light array

 Infrared wavelength (typical): 950 nm

According to published research, zebrafish are sensitive to infrared 
light, though not above 910 nm. See Shcherbakov et al. 2013, PLoS 
ONE 8(5): e64429. The IR light provided by DanioVision is therefore 
unlikely to affect the fish’s behavior.

 White light color temperature (typical): 5500ºK

 White light level controllable via USB (EthoVision XT). Intensity 
range: 0 to ±10000 lux (light level measured directly at the bottom 
of the water basin).

With the standard White Light settings, the light intensities of the 
white light are approximately:

 
note  If you set the Low Light switch to L (low), the highest light 
level (100%) is around 20 lux. See configure the daniovision 
white light on page 37 for more information.

Percentage Steps Intensity (lux)

5 207 139

25 1000 2500

50 2100 5300

75 3000 8000

100 4095 10500
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note Light intensity in DVOC-0041 can be set higher than in DVOC-
0040. Here the reference values if you have DVOC-0040:

You may want to replicate light conditions that you set in 
DanioVision DVOC-0040 in a new experiment with DanioVision 
DVOC-0041. For example, if you set light intensity to 50% in 
DanioVision DVOC-0040, this gave 2950 lux. The percentage to be 
set in DanioVision DVOC-0041 is (2950/5300)*50 = approx. 28%.

Multi basin

 Water inlet, water outlet and overflow 

 Basin size 158 x 132 mm (6 7/32” x 5 13/64”)

 Supports ANSI, SBS compatible micro plates (L =127.76± 0.5 mm  
(5 1/32” ± 1/64”), W=85.48 ± 0.5 mm (3 23/64” ± 1/64”) with 
maximum height of 27mm (1 1/16”)

 Supports Petri dishes up to 90 mm (3 35/64”) in diameter

 Temperature sensor supporting the use of Noldus DVTCU 
(Temperature Control Unit)

Water connections

 Water inlet/outlet: tube fitting 8 mm

 Water overflow: tube fitting 10 mm

Tubes included

 1.5 m Clear PVC Hose, 8 mm OD, 5 mm ID for water inlet (green color 
marked)

Percentage Steps Intensity (lux)

1% 40 70

25% 1025 1450

50% 2050 2950

75% 3000 4400

100% 4096 5450
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 1.5 m Clear PVC Hose, 8 mm OD, 5 mm ID for water outlet (yellow 
color marked)

 1.5 m Clear PVC Hose, 10 mm OD, 8 mm ID for water overflow (red 
color marked)

PC interface

 USB-2 compatible

External I/O

 TTL input/output (4x modular RJ45 connector):

- 4 x 2 TTL input

- 4 x 2 TTL output

 TTL expansion port 1:

- 4 x TTL output (open collector output)

- 1 x input camera

- 1 x output camera

 TTL expansion port 2 (1x modular RJ45 connector:

- 8-pin feed through

System start-up time (cold start)

 ~ 15 minutes

Cleaning the DanioVision Observation Chamber

 Outside of the chamber: We recommend to use a propriety glass-
cleaning fluid or a detergent solution to clean the outside of the 
DanioVision Observation Chamber.

 Inside parts (Fresnell lens, lens heater, etc.): Only use a damp cloth 
dipped in a mild detergent solution with warm/lukewarm water. 
Use a micro fiber cloth, so that the cloth is just damp and leaves no 
droplets on the surface.

Declaration of conformity

See page 188.
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daniovision temperature control unit (tcu)

Dimensions (L x W x H)

 460 x 210 x 280 mm/ 18” 11 x 8” 26 x 11” 02

 Hose connectors 8 mm outer diameter tube

Weight

7 kg / 15.43 pound

Electrical

 Operating voltage: 24 V DC

 Power consumption (Average / Maximum): 40 / 120 W

 TTL port specs: 2 input / 2 output Max. 5 Volt / Max. 5 Volt, open 
collector

Operational

 Temperature accuracy: ± 0.5 °C / ± 0.9 °F

 Temperature set point range: 15 - 40 °C / 59 - 104 °F

 Maximum heating capacity: At least 10 °C / 18 °F above ambient 
temperature (within the temperature set point range 15-40 °C / 59-
104 °F)

 Maximum cooling capacity: 2.5 °C / 4.5 °F below ambient 
temperature (within the temperature set point range 15-40 °C / 59-
104 °F)

 Permissible water temperature range: 5 - 50 °C / 41 - 122 °F

 Water capacity: ± 350 ml / ± 11.83 oz

 Pump flow rate – water: ± 310 ml per min / ± 10.48 oz per min

 Water filter type: 20 μm pore size, 1 inch diameter

 Cooling liquid capacity: ± 250 ml / ± 8.45 oz

 Cooling liquid type: Colored, anti-corrosive, anti-algae, PC-type 
cooling liquid
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 Pump flow rate – cooling liquid: ± 1650 ml per min / ± 55.79 oz per 
min

 Maximum height difference DVOC and TCU: 1.3 m / 4.26 ft.

important  Do not place the Temperature Control Unit higher than 
the Observation Chamber!

 Noise level: Average over all frequencies < 35 dB; Max. peak of ±48 
dB around 160 Hz

Environmental conditions

 Permissible ambient temperature range: 

- Operating: 10 - 35 °C / 50 - 95 °F 

- Storage: 5 - 65 °C / 41 - 149 °F

 Permissible relative humidity: 20% - 80% (non-condensing)

daniovision tapping device

Dimensions

 Tapping Device (including aluminum bracket): 6 x 24 x 7.5 cm / 
(2 23/64” x 9 29/64” x 2 61/64”) (h x w x d)

 Control box: 2.5 x 10 x 6.5 cm (63/64” x 3 15/16” x 2 9/16”) (h x w x d)

Weight

 ~ 300g (Tapping Device, bracket, control box) 

 If not pre-assembled in the DVOC-0041, the package includes 
mounting material

Power

 Power requirements: 24 Volt DC, 0.4Amp (max)

Features

 Controlled from EthoVision XT 10.1 or later with selectable stimulus 
intensity (1-8)
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 Delivers a discrete ‘tap’ to the well plate holder

 Maximum tapping rate of ±3 taps per second

Connectors

 Molex 2 pin – Power (24V)

 Molex 4 pin – From Tapping Device to control box

 Multi connector (blue) – For TTL control signal

Compatible DanioVision Chambers

 DVOC-0040, DVOC-0041

daniovision toplight unit

Dimensions

270 x 220 x 30mm   (10 5/8” x 8 21/32” x 1 3/16”)

White light

> 30.000 lux at 25cm distance (well plate), 1584 lm

Color temperature 4000K

Array of 408 LED’s

Max. voltage 18 Volt

Red light

192 lm, wavelength 623 nm

Array of 252 RGB LED’s

Max. voltage 24 Volt

Green light

384 lm, wavelength 525 nm

Array of 252 RGB LED’s
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Max. voltage 24 Volt

Blue light

240 lm, wavelength 470 nm

Array of 252 RGB LED’s

Max. voltage 24 Volt
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declarations of conformity

DanioVision DVOC
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Power supply of DVOC-0041
D - System specifications 189



Power supply of DV-TCU
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